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TT™ 15X/TT 15 mini Dog Collar Device 
Quick Start Manual

Getting Started
 WARNING

See the Important Safety and Product Information guide in the product box for product warnings and other 
important information.

Dog Collar Device
NOTE: Your dog collar device may look different than the device pictured.

VHF antenna

GPS antenna

Power button

Contact points

Status LED and flashing beacon LEDs
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Turning On the Device
• On the dog collar device, hold the power button until the status LED flashes and the collar beeps.

Turning Off the Dog Collar Device
Hold the power button until the status LED turns solid red and the device beeps.

Charging the Dog Collar Device
NOTICE

To prevent corrosion, thoroughly dry the contacts on the collar and the surrounding area before connecting the 
charging clip.

NOTE: Your dog collar device may look different than the device pictured.
You should fully charge the battery before you use the device for the first time. Charging a fully depleted battery 
takes about five hours.
1 Snap the charging clip  onto the device .

2 Plug the small end of the power cable into the mini-USB port on the charging clip cable.
3 Plug the power cable into a power source.

The status LED is solid red when the collar is charging.
4 After the status LED turns solid green, remove the charging clip from the collar.

Acquiring Satellite Signals
Both the collar and handheld device must acquire satellite signals before you put the collar on your dog. 
Acquiring satellites can take a few minutes.
1 Go outdoors to an open area.
2 Turn on both devices.

 in the status bar shows the GPS signal strength.
When the collar has acquired satellite signals, the status LED flashes a double-blink or triple-blink in green.
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Adding a Dog to the Alpha® Handheld Using Wireless Pairing
1 If the dog collar device is on, turn off the dog collar device.
2 Hold the power key on the dog collar device until the device emits two series of beeps (about 2 seconds), 

and then release the power button.
The status LED flashes rapidly in green. The dog collar device is now ready to be linked, or paired, with a 
handheld device.

3 On the handheld device, select Dog List > Add Dog.
4 Select an option:

• If you are near the dog collar device, select Pair Collar, and follow the on-screen instructions.
• To pair a dog collar device by receiving the information from another handheld device, select Receive 

from Handheld.
NOTE: To successfully pair the device, the other handheld device must be wirelessly sharing the dog collar 
device information.

5 After successfully adding the dog collar device, enter the name of the dog, and select .

Selecting and Installing the Contact Points
 CAUTION

To prevent irritation from the contact points, remove the collar for at least eight hours out of every 24-hour 
period.
Do not spray the device or collar with harsh chemicals including but not limited to flea or tick spray. Always 
ensure that any flea or tick spray that is applied to the dog is completely dry before placing the collar on the dog. 
Small amounts of harsh chemicals can damage the plastic components and collar laminate.

For best results, select the correct contact points based on your dog's coat.
1 Select the correct contact point length for your dog's coat type:

• For dogs with thicker coats, use the longer contact points.
• For dogs with shorter coats, use the shorter contact points.

2 If necessary, use the included wrench to remove the contact points.
3 Twist the contact points into the collar.
4 Tighten with the included wrench, but do not overtighten.
When you put the collar on the dog, make sure the contact points are tight against the neck.
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Fitting the Collar on Your Dog
 CAUTION

To prevent irritation from the contact points, remove the collar for at least eight hours out of every 24-hour 
period.
This device is not intended for human use. Do not attempt to use on any person.
Do not spray the device or collar with harsh chemicals including but not limited to flea or tick spray. Always 
ensure that any flea or tick spray that is applied to the dog is completely dry before placing the collar on the dog. 
Small amounts of harsh chemicals can damage the plastic components and collar laminate.

In order to effectively train the dog, the collar and device must fit the dog properly. If the collar is too loose or 
positioned incorrectly, stimulation may be inconsistent. This can delay or prevent successful training.
1 Position the device at the front of the dog's neck, with the status LED facing toward the dog's chin and the 

contact points against the throat.
2 Tighten the strap so that it is very snug around the dog's neck, and fasten the buckle.

NOTE: The collar should fit tightly and should not be able to rotate or slide on the dog's neck. The dog must 
be able to swallow food and water normally. You should observe your dog's behavior to verify that the collar 
is not too tight.

3 Wiggle the device to work the contact points through the dog's coat.
NOTE: The contact points must have contact with the dog's skin to be effective.

4 If the strap is too long, cut off the excess, leaving at least 8 cm (3 in.) to spare.
TIP: You can mark the hole used to fasten the buckle for future reference.

Dog Tracking and Training
One handheld device can track multiple dog collar devices and other handheld devices.

Dog Tracking
The handheld device allows you to track your dog or multiple dogs, using the tracking compass or map. The 
map displays your location and your dog's location and tracks. The compass pointer indicates the direction of 
the dog's current location.
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Dog Training
NOTICE

You should research and investigate the training methods best suited for you, your dog, and your needs. This 
manual provides some basic guidelines for training, but each dog has unique training needs.
When used properly, the Alpha training system is a very effective training tool to aid your dog in reaching its full 
potential. The use of the training system should be part of an overall training program.

Begin training your dog on a leash, without the Alpha training system. You should train your dog how to heel, sit, 
and come to you. After the dog understands these three basic commands, you can begin training with the dog 
collar device and the leash. Finally, when the dog consistently obeys commands using the leash and collar, you 
may be able to remove the leash to train with only the dog collar device.

Communication with the Collar
You should keep an unobstructed line of sight between your handheld device and the dog collar device to 
produce the best communication signal. To achieve the best line-of-sight conditions, you should move to the 
highest elevation point in your area (for example, on the top of a hill).

Best

Good

Poor

Entering Sleep Mode
NOTE: This feature is not available with all dog collar device models.
Before you can enter sleep mode, you must track your dog's location using the compatible dog collar device.
When connected with the handheld device, the dog collar device can be put into sleep mode to conserve the 
battery when you are not actively tracking your dog.
1 Select Dog List.
2 Select a dog.
3 Select  > Adjust Collar Sleep Mode > Sleep.

Exiting Sleep Mode
NOTE: This feature is not available with all dog collar device models.
You can exit sleep mode on the compatible dog collar device while you are not actively tracking your dog.
1 Select Dog List.
2 Select a dog.
3 Select  > Adjust Collar Sleep Mode > Wake.
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Device Information

Getting the Owner's Manual
You can get the latest owner's manual from the web.
1 Go to www.garmin.com/support.
2 Select Manuals.
3 Follow the on-screen instructions to select your product.

Updating the Dog Collar Device Software
Before you can update the dog collar device software, you must connect the dog collar device to a computer.
NOTE: PC only. Updating the software does not erase any of your data or settings.
1 Go to www.garmin.com/products/webupdater.
2 Follow the on-screen instructions.

VHF Radio Information
This product may be used only on specific radio frequencies, which vary depending on the country of use. The 
handheld device and the dog device allow the user to install a different antenna. Changing the antenna can 
result in improved radio performance and higher radiated power. You must not use the device with a third party 
antenna or an antenna not approved by Garmin®. Go to www.garmin.com/tracking-legal for details about the 
performance and radio frequency of this product, lawful accessories, and power limits for countries.

Securing the Antenna and Antenna Keeper to the Collar
NOTICE

When using cable ties, ensure no sharp edges are in contact with your dog's skin.

You can secure the antenna and antenna keeper to the collar to optimize the fit of the dog collar device on your 
dog.
For maximum radio performance, the antenna should be pointed straight up when positioned on your dog. 
Depending on the size of your dog's neck, you may need to use cable ties to properly position the antenna.
1 Secure the antenna keeper  to the collar with one of the provided cable ties .

2 Secure the antenna  to the collar with one of the provided cable ties .
3 Cut off the excess length from the cable ties.
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Dog Collar Device Specifications
Battery type Rechargeable, replaceable lithium-ion, 361-00029-04

Operating temperature range From -20° to 60°C (from -4° to 140°F)

Charging temperature range From 0° to 40°C (from 32° to 104°F )

Wireless frequencies/protocols 152-169 MHz @ 24.2 dBm maximum, 2.4 GHz @ 6.9 dBm maximum

EU SAR 0.06 W/kg simultaneous torso, 0.07 W/kg simultaneous limb

Mini Dog Collar Device Specifications
Battery type Rechargeable, replaceable lithium-ion, 361-00035-09

Operating temperature range From -20° to 60°C (from -4° to 140°F)

Charging temperature range From 5° to 40°C (from 41° to 104°F)

Wireless frequencies/protocols 155 MHz @ 32.77 dBm maximum, 2.4 GHz @ -1.7 dBm maximum

8 Quick Start Manual



Appareil pour collier canin TT™ 15X/TT 15 mini
Manuel de démarrage rapide

Mise en route
 AVERTISSEMENT

Consultez le guide Informations importantes sur le produit et la sécurité inclus dans l'emballage du produit pour 
prendre connaissance des avertissements et autres informations importantes sur le produit.

Appareil pour collier de chien
REMARQUE : votre appareil pour collier de chien peut avoir une apparence différente par rapport à l'image.

Antenne VHF

Antenne GPS

Bouton Marche/Arrêt

Points de contact

Voyant DEL d'état et balises clignotantes à LED
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Mise sous tension de l'appareil
• Sur l'appareil pour collier canin, appuyez sur le bouton Marche/Arrêt jusqu'à ce que le voyant LED d'état 

clignote et que le collier émette un signal sonore.

Mise hors tension de l'appareil pour collier canin
Maintenez le bouton Marche/Arrêt enfoncé jusqu'à ce que le voyant LED d'état devienne rouge fixe et que 
l'appareil émette un signal sonore.

Chargement de l'appareil pour collier de chien
AVIS

Pour éviter tout risque de corrosion, essuyez soigneusement les contacts du collier et la zone environnante 
avant de connecter l'appareil au clip de chargement.

REMARQUE : votre appareil pour collier de chien peut avoir une apparence différente par rapport à l'image.
Veuillez charger complètement la batterie avant d'utiliser l'appareil pour la première fois. Le chargement d'une 
batterie complètement déchargée dure environ cinq heures.
1 Refermez le clip de chargement  sur l'appareil .

2 Branchez la petite extrémité du câble d'alimentation dans le port mini-USB situé sur le câble du clip de 
chargement.

3 Branchez le câble d'alimentation sur une source d'alimentation.
Le voyant DEL d'état reste rouge pendant toute la durée du chargement du collier.

4 Lorsque le voyant DEL d'état est vert, retirez le clip de chargement du collier.

Acquisition des signaux satellites
Avant de placer le collier sur le cou de votre chien, le collier et l'appareil portable doivent acquérir des signaux 
satellites. L'acquisition des signaux satellites peut prendre quelques minutes.
1 Placez-vous à l'extérieur dans une zone dégagée.
2 Mettez les deux appareils sous tension.

L'icône  qui s'affiche dans la barre d'état indique l'intensité du signal GPS.
Lorsque des signaux satellites ont été captés par l'appareil, le voyant DEL d'état clignote en vert à deux ou trois 
reprises.
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Ajout d'un chien à l'appareil portable Alpha par couplage sans fil
1 Si l'appareil pour collier de chien est activé, désactivez-le.
2 Maintenez enfoncé le bouton Marche/Arrêt de l'appareil pour collier canin jusqu'à ce qu'il émette deux séries 

de bips (environ 2 secondes), puis relâchez le bouton.
Le voyant DEL d'état clignote rapidement en vert. L'appareil pour collier de chien est maintenant prêt à être 
lié, ou couplé , avec l'appareil portable.

3 Sur l'appareil portable, sélectionnez Liste des chiens > Ajouter un chien.
4 Sélectionner une option :

• Si vous vous trouvez à proximité de l'appareil pour collier canin, sélectionnez Coupler le collier, puis 
suivez les instructions qui s'affichent à l'écran.

• Pour coupler un appareil pour collier canin en recevant des informations à partir d'un autre appareil 
portable, sélectionnez Recevoir de l'app. portable.
REMARQUE : pour que le couplage de l'appareil réussisse, l'autre appareil portable doit partager les 
informations de l'appareil pour collier canin via le réseau sans fil.

5 Après avoir ajouté l'appareil pour collier canin, saisissez le nom du chien et sélectionnez .

Sélection et installation des points de contact
 ATTENTION

Pour éviter toute irritation due aux points de contact, retirez le collier au moins 8 heures par période de 
24 heures.
Ne pulvérisez jamais de produits chimiques sur l'appareil ou le collier, notamment des répulsifs contre les puces 
ou les tiques. Veillez toujours à ce que les produits contre les puces ou les tiques pulvérisés sur le chien ont 
séché entièrement avant de passer un collier à l'animal. De petites quantités de produits chimiques suffisent à 
endommager les composants plastiques et les éléments stratifiés du collier.

Pour des résultats optimaux, sélectionnez les points de contact en fonction du pelage du chien.
1 Sélectionnez la longueur des points de contact en fonction du pelage du chien :

• Plus le pelage du chien est épais, plus les points de contact doivent être longs.
• Plus le pelage du chien est court, plus les points de contact doivent être courts.

2 Si nécessaire, utilisez la clé incluse pour retirer les points de contact.
3 Fixez les points de contact dans le collier.
4 Serrez-les à l'aide de la clé fournie, mais ne serrez pas outre mesure.
Lorsque vous placez le collier sur le chien, assurez-vous que les points de contact sont correctement ajustés 
autour de son cou.
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Ajustement du collier au chien
 ATTENTION

Pour éviter toute irritation due aux points de contact, retirez le collier au moins 8 heures par période de 
24 heures.
Cet appareil n'est pas conçu pour un usage humain. Ne tentez pas de l'utiliser sur qui que ce soit.
Ne pulvérisez jamais de produits chimiques sur l'appareil ou le collier, notamment des répulsifs contre les puces 
ou les tiques. Veillez toujours à ce que les produits contre les puces ou les tiques pulvérisés sur le chien ont 
séché entièrement avant de passer un collier à l'animal. De petites quantités de produits chimiques suffisent à 
endommager les composants plastiques et les éléments stratifiés du collier.

Pour dresser efficacement le chien, le collier et l'appareil doivent être correctement ajustés autour du cou du 
chien. Si le collier n'est pas assez serré ou s'il est mal positionné, la stimulation peut manquer de cohérence. 
Ceci peut ralentir ou empêcher la réussite du dressage.
1 Positionnez l'appareil à l'avant du cou du chien, le voyant DEL d'état dirigé vers la mâchoire du chien et les 

points de contact contre sa gorge.
2 Serrez la sangle pour qu'elle soit bien ajustée autour du cou du chien et attachez la boucle.

REMARQUE : le collier doit être parfaitement ajusté afin qu'il ne puisse pas tourner ou glisser sur le cou du 
chien. Le chien doit pouvoir avaler normalement sa nourriture et son eau. Observez le comportement de 
votre chien pour vous assurer que son collier n'est pas trop serré.

3 Ajustez l'appareil pour que les points de contact passent la barrière de la fourrure.
REMARQUE : pour être efficaces, les points de contact doivent être en contact avec la peau du chien.

4 Si la sangle est trop longue, coupez l'excédent en gardant au moins 8 cm (3’’) de jeu.
ASTUCE : vous pouvez marquer le trou utilisé pour attacher la boucle afin de vous y référer ultérieurement.

Suivi et dressage de chiens
Un appareil portable peut suivre plusieurs appareils pour collier canin et autres appareils portables.
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Suivi de chien
L'appareil portable vous permet de suivre un ou plusieurs chiens à l'aide du compas ou de la carte de suivi. La 
carte affiche votre position et celle de votre chien ainsi que les données de suivi. Le pointeur du compas indique 
dans quelle direction se trouve le chien.

Dressage de chien
AVIS

Recherchez et étudiez les méthodes de dressage qui correspondent le mieux au chien, à vous-même et à vos 
besoins. Ce manuel contient des conseils de base pour le dressage, mais chaque chien a ses propres besoins 
en matière de dressage.
S'il est utilisé correctement, le système de dressage Alpha est une aide efficace permettant au chien d'atteindre 
son meilleur niveau. L'utilisation du système de dressage doit entrer dans le cadre d'un programme de dressage 
exhaustif.

Commencez le dressage du chien avec une laisse, sans l'aide du système de dressage Alpha . Vous devez 
apprendre au chien les ordres suivants : « Au pied », « Assis », « Viens ». Une fois que le chien comprend ces 
trois ordres de base, vous pouvez poursuivre le dressage en utilisant l'appareil pour collier de chien et la laisse. 
Enfin, lorsque le chien obéit systématiquement aux ordres avec le collier et la laisse, vous pouvez essayer de 
passer au dressage sans la laisse, uniquement à l'aide de l'appareil pour collier de chien.

Communication avec le collier
Assurez-vous qu'aucun obstacle ne se trouve entre l'appareil portable et l'appareil pour collier de chien afin 
d'obtenir un signal de communication optimal. Pour bénéficier de conditions de visibilité optimales, rendez-vous 
au point d'altitude le plus élevé de votre secteur (par exemple, le sommet d'une colline).

Optimal

Bon

Mauvais
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Entrée en mode veille
REMARQUE : cette fonction n'est pas disponible sur tous les modèles d'appareil pour collier canin.
Pour pouvoir passer en mode veille, vous devez suivre la position de votre chien à l'aide de l'appareil pour collier 
canin compatible.
Lorsqu'il est connecté à l'appareil portable, l'appareil pour collier canin peut être placé en mode veille pour 
préserver l'autonomie de la batterie quand vous ne suivez pas activement votre chien.
1 Sélectionnez Liste des chiens.
2 Sélectionnez un chien.
3 Sélectionnez  > Régler mde veille du collier > Veille.

Sortie du mode veille
REMARQUE : cette fonction n'est pas disponible sur tous les modèles d'appareils pour collier canin.
Vous pouvez quitter le mode veille sur le collier canin connecté compatible quand vous ne suivez pas 
activement votre chien.
1 Sélectionnez Liste des chiens.
2 Sélectionnez un chien.
3 Sélectionnez  > Régler mde veille du collier > Sortir.

Informations sur l'appareil

Téléchargement du manuel d'utilisation
Vous pouvez obtenir la dernière version du manuel d'utilisation sur Internet.
1 Rendez-vous sur le site www.garmin.com/support.
2 Sélectionnez Manuels d'utilisation.
3 Suivez les instructions à l'écran pour sélectionner votre produit.

Mise à jour du logiciel de l'appareil pour collier canin
Pour pouvoir mettre à jour le logiciel de l'appareil pour collier canin, vous devez connecter l'appareil pour collier 
canin à un ordinateur.
REMARQUE : pC uniquement. la mise à jour du logiciel n'efface pas vos données ni vos paramètres.
1 Rendez-vous sur le site www.garmin.com/products/webupdater.
2 Suivez les instructions présentées à l'écran.

Informations concernant la radio VHF
Ce produit doit uniquement être utilisé sur des fréquences radio spécifiques susceptibles de varier en fonction 
du pays d'utilisation. L'appareil portable et l'appareil pour chien permettent à l'utilisateur d'installer une autre 
antenne. Une autre antenne peut entraîner une amélioration des performances radio et une augmentation de la 
puissance de rayonnement. N'utilisez pas l'appareil avec une antenne fournie par un tiers ou une antenne qui n'a 
pas été approuvée par Garmin. Rendez-vous sur www.garmin.com/tracking-legal pour obtenir des informations 
sur les performances et la fréquence radio de ce produit, les accessoires respectant la législation en vigueur et 
sur les limites de puissance spécifiques à votre pays.
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Fixation de l'antenne et de son maintien au collier
AVIS

Si vous utilisez des attaches de câble, assurez-vous qu'aucun bord coupant n'est en contact avec votre chien.

Vous pouvez fixez l'antenne et son maintien au collier pour optimiser la tenue de l'appareil de collier de chien 
sur votre animal.
Pour des performances radio optimales, l'antenne doit être dirigée vers le haut sur votre chien. En fonction de la 
taille du cou de votre chien, vous devrez peut-être utiliser des attaches de câbles pour positionner l'antenne 
convenablement.
1 Fixez le maintien de câble  au collier à l'aide d'une des attaches fournies .

2 Fixez l'antenne  au collier à l'aide d'une des attaches fournies .
3 Si besoin, raccourcissez les attaches.

Caractéristiques techniques de l'appareil pour collier de chien
Type de pile Lithium-ion rechargeable remplaçable, 361-00029-04

Plage de températures de fonctionnement de -20 à 60 °C (de -4 à 140 °F)

Plage de températures de chargement De 0 à 40 °C (de 32 à 104 °F)

Fréquences/Protocoles sans fil De 152 à 169 MHz à 24,2 dBm maximum ; 2,4 GHz à 6,9 dBm 
maximum

DAS UE 0,06 W/kg torse simultané, 0,07 W/kg membre simultané

Caractéristiques techniques de l'appareil pour collier canin Mini
Type de pile Lithium-ion rechargeable remplaçable, 361-00035-09

Plage de températures de fonctionnement de -20 à 60 °C (de -4 à 140 °F)

Plage de températures de chargement De 5 à 40 °C (de 41 à 104 °F)

Fréquences/Protocoles sans fil 155 MHz à 32,77 dBm maximum ; 2,4 GHz à -1,7 dBm maximum
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Collare per cani TT™ 15X/TT 15 mini
Manuale di avvio rapido

Operazioni preliminari
 AVVERTENZA

Per avvisi sul prodotto e altre informazioni importanti, consultare la guida inclusa nella confezione del 
dispositivo.

Collare
NOTA: il collare in uso potrebbe apparire diverso dal dispositivo raffigurato nell'immagine.

Antenna VHF

Antenna GPS

Tasto di accensione

Punti di contatto

LED di stato e lampeggianti luminosi
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Accensione del dispositivo
• Sul collare tenere premuto il pulsante di accensione finché il LED di stato non lampeggia e il collare emette 

un segnale acustico.

Spegnimento del collare
Tenere premuto il pulsante di accensione finché il LED di stato non diventa rosso e il dispositivo non emette 
un segnale acustico.

Caricare il collare
AVVISO

Per prevenire fenomeni di corrosione, asciugare i contatti del collare e l'area circostante prima di collegare il 
dispositivo di ricarica.

NOTA: l'aspetto del collare in uso potrebbe essere diverso dal dispositivo raffigurato.
È necessario caricare completamente la batteria prima di utilizzare il dispositivo per la prima volta. La ricarica di 
una batteria completamente scarica necessita di circa cinque ore.
1 Inserire il dispositivo di ricarica  nel dispositivo .

2 Collegare l'estremità più piccola del cavo di alimentazione alla porta mini-USB sul cavo della clip per ricarica.
3 Collegare il cavo di alimentazione a una fonte di alimentazione.

Il LED di stato rimane rosso fisso quando il collare è in ricarica.
4 Una volta che il LED di stato diventa verde fisso, rimuovere il dispositivo di ricarica dal collare.

Acquisizione del segnale satellitare
Il collare e il dispositivo portatile devono acquisire i segnali satellitari prima di poter mettere il collare al cane. 
L'acquisizione dei satelliti può richiedere qualche minuto.
1 Recarsi in un'area all'aperto.
2 Accendere entrambi i dispositivi.

 nella barra di stato indica la potenza del segnale GPS.
Quando il collare ha acquisito i segnali satellitari, il LED di stato lampeggia due o tre volte in verde.
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Aggiunta di un cane al dispositivo portatile Alpha tramite l'associazione wireless
1 Se il collare per cani è acceso, spegnerlo.
2 Tenere premuto il tasto di accensione sul collare finché non vengono emesse due serie di segnali acustici 

(circa 2 secondi), quindi rilasciarlo.
Il LED di stato lampeggia rapidamente in verde. Il collare per cani è ora pronto per essere collegato, o 
associato, a un dispositivo portatile.

3 Sul dispositivo portatile, selezionare Elenco cani > Aggiungi cane.
4 Selezionare un'opzione:

• In prossimità del collare, selezionare Associa collare e seguire le istruzioni visualizzate.
• Per associare un collare ricevendo le informazioni da un altro dispositivo portatile, selezionare Ricezione 

dal disp. portatile.
NOTA: per associare correttamente il dispositivo, l'altro dispositivo portatile deve condividere in modalità 
wireless le informazioni sul collare.

5 Dopo aver associato il collare, digitare il nome del cane e selezionare .

Selezione e installazione dei punti di contatto
 ATTENZIONE

Per impedire irritazioni derivanti dai punti di contatto, rimuovere il collare per almeno otto ore ogni 24.
Non spruzzare sul dispositivo o sul collare prodotti chimici corrosivi, ad esempio repellenti per insetti. 
Accertarsi sempre che l'eventuale prodotto spruzzato sul cane si sia asciugato completamente prima di mettere 
il collare al cane. Piccole quantità di sostanze chimiche corrosive possono danneggiare i componenti in plastica 
e il laminato del collare.

Per risultati ottimali, selezionare i punti di contatto corretti in base al pelo del cane.
1 Selezionare la lunghezza corretta dei punti di contatto per il tipo di pelo del cane:

• Per i cani a pelo lungo, utilizzare i punti di contatto più lunghi.
• Per i cani a pelo corto, utilizzare i punti di contatto più corti.

2 Se necessario, utilizzare l'utensile incluso per rimuovere i punti di contatto.
3 Avvitare i punti di contatto sul collare.
4 Serrare con l'utensile incluso, senza forzare eccessivamente.
Quando il collare è indossato, accertarsi che i punti di contatto si trovino a contatto del collo del cane.
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Mettere il collare al cane
 ATTENZIONE

Per impedire irritazioni derivanti dai punti di contatto, rimuovere il collare per almeno otto ore ogni 24.
Questo dispositivo non è progettato per l'uso sugli essere umani. Non tentare di utilizzarlo sulle persone.
Non spruzzare sul dispositivo o sul collare prodotti chimici corrosivi, ad esempio repellenti per insetti. 
Accertarsi sempre che l'eventuale prodotto spruzzato sul cane si sia asciugato completamente prima di mettere 
il collare al cane. Piccole quantità di sostanze chimiche corrosive possono danneggiare i componenti in plastica 
e il laminato del collare.

Per correggere il cane in modo efficace, è necessario adattare perfettamente il collare e il dispositivo al cane. 
Se il collare è allentato o non si trova nella posizione appropriata, le stimolazioni potrebbero risultare inefficaci, 
rischiando di rallentare o impedire l'addestramento.
1 Posizionare il dispositivo nella parte anteriore del collo del cane, con il LED di stato rivolto verso il mento del 

cane e i punti di contatto contro la gola.
2 Stringere la cinghia in modo che aderisca perfettamente al collo del cane, quindi chiudere la fibbia.

NOTA: il collare deve essere fissato saldamente e non deve ruotare o scorrere sul collo del cane. Il cane 
deve poter deglutire cibo e acqua normalmente. Osservare il comportamento del cane per verificare che il 
collare non sia troppo stretto.

3 Continuare a muovere avanti e indietro il dispositivo per affondare i punti di contatto nel pelo del cane.
NOTA: i punti di contatto devono toccare la pelle del cane per funzionare.

4 Se il cinturino è troppo lungo, tagliare le parti in eccesso, lasciando almeno 8 cm (3 poll.) di tessuto in più.
SUGGERIMENTO: è consigliabile contrassegnare il foro utilizzato per allacciare la fibbia come riferimento 
futuro.

Rilevamento e addestramento di cani
Un dispositivo portatile può tracciare diversi collari per cani e altri dispositivi portatili.
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Tracciamento del cane
Il dispositivo portatile consente di tracciare più cani utilizzando la bussola o la mappa. La mappa visualizza la 
posizione dell'utente e quella del cane ed esegue il tracciamento. Il cursore della bussola indica la direzione 
della posizione corrente del cane.

Addestramento del cane
AVVISO

Cercare ed esaminare i metodi di addestramento più adatti in base alle proprie esigenze e a quelle del cane. 
Questo manuale fornisce alcune linee guida di base, ma ogni cane è diverso dall'altro e ha le proprie esigenze 
specifiche.
Quando utilizzato correttamente, il sistema di addestramento Alpha è uno strumento molto efficace e consente 
di pervenire ad ottimi risultati. L'utilizzo del sistema di addestramento deve essere parte di un programma di 
addestramento completo.

Iniziare l'addestramento del cane utilizzando il solo guinzaglio, senza ricorrere per il momento al sistema di 
addestramento Alpha . Addestrare il cane a camminare al vostro fianco, a sedersi e a venire verso di voi. Una 
volta che il cane ha compreso questi tre comandi di base, è possibile iniziare l'addestramento vero e proprio con 
il collare e con il guinzaglio. Infine, quando il cane è in grado di obbedire in modo coerente ai comandi trasmessi 
tramite guinzaglio e collare, è possibile rimuovere il guinzaglio e continuare l'addestramento con il solo collare.

Comunicazione con il collare
È necessario mantenere una linea di vista priva di ostacoli da il dispositivo portatile e il collare per cani, al fine di 
produrre il miglior segnale di comunicazione. Per ottenere le migliori condizioni di linea di vista, spostarsi sul 
punto di quota più elevato dell'area (ad esempio, in cima a una collina).

Ottimo

Buono

Scarso
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Attivazione della modalità di sospensione
NOTA: questa funzione non è disponibile in tutti i modelli di collare.
Prima di attivare la modalità di sospensione, è necessario rilevare la posizione del cane utilizzando il collare 
compatibile.
Se collegato al dispositivo portatile, il collare può essere impostato in modalità di sospensione per ridurre il 
consumo della batteria quando non si sta monitorando attivamente il cane.
1 Selezionare Elenco cani.
2 Selezionare un cane.
3 Selezionare  > Regola mod. sosp. collare > Sospensione.

Disattivazione della modalità di sospensione
NOTA: questa funzione non è disponibile in tutti i modelli di collare.
È possibile disattivare la modalità di sospensione sul collare compatibile se non si sta rilevando attivamente il 
cane.
1 Selezionare Elenco cani.
2 Selezionare un cane.
3 Selezionare  > Regola mod. sosp. collare > Riattiva.

Info sul dispositivo

Manuale Utente
La versione più recente del Manuale Utente può essere scaricata dal Web.
1 Visitare il sito Web www.garmin.com/support.
2 Selezionare Manuali.
3 Attenersi alle istruzioni riportate sullo schermo per selezionare il prodotto in uso.

Aggiornamento del software del collare per cani
Prima di aggiornare il software del collare per cani, è necessario collegare il collare a un computer.
NOTA: solo PC. Con l'aggiornamento del software non vengono cancellati i dati o le impostazioni.
1 Visitare il sito Web www.garmin.com/products/webupdater.
2 Seguire le istruzioni visualizzate sullo schermo.

Specifiche radio VHF
Questo prodotto può essere utilizzato solo su frequenze radio specifiche, che variano a seconda del Paese di 
utilizzo. Il dispositivo portatile e il dispositivo per cani consentono all'utente di installare un'antenna differente. 
Cambiare l'antenna può migliorare le prestazioni della radio e irradiare maggiore potenza. Non utilizzare il 
dispositivo con un'antenna di terze parti o con un'antenna non approvata da Garmin. Visitare la pagina Web 
www.garmin.com/tracking-legal per informazioni dettagliate sulle prestazioni e la frequenza radio di questo 
prodotto, gli accessori a norma di legge e i limiti di potenza per i Paesi.
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Fissaggio dell'antenna e del sostegno dell'antenna al collare
AVVISO

Quando si utilizzano le fascette, accertarsi che non vi siano bordi taglienti a contatto con la pelle del cane.

È possibile fissare l'antenna e il sostegno al collare per ottimizzare l'aderenza del dispositivo sul cane.
Per ottimizzare le prestazioni di comunicazione via radio, l'antenna deve puntare verso l'alto quando viene 
posizionata sul cane. A seconda delle dimensioni del collo del cane, potrebbe essere necessario utilizzare una o 
due fascette per fissare bene l'antenna.
1 Fissare il sostegno dell'antenna  al collare con una delle fascette in dotazione .

2 Fissare l'antenna  al collare con una delle fascette in dotazione .
3 Tagliare la parte in eccesso delle fascette.

Specifiche del collare per cani
Tipo di batteria Batteria ricaricabile e sostituibile agli ioni di litio, 361-00029-04

Intervallo temperatura di 
esercizio Da -20° a 60 °C (da -4° a 140 °F)

Intervallo temperatura di ricarica Da 0 a 40 °C (da 32 a 104 °F)

Frequenze/Protocolli wireless 152-169 MHz a 24,2 dBm massimo, 2,4 GHz a 6,9 dBm massimo

EU SAR 0,06 W/kg tronco (trasmissione simultanea), 0,07 W/kg arto (trasmissione 
simultanea)

Specifiche del collare Mini
Tipo di batteria Batteria ricaricabile e sostituibile agli ioni di litio, 361-00035-09

Intervallo temperatura di esercizio Da -20° a 60 °C (da -4° a 140 °F)

Intervallo temperatura di ricarica Da 5° a 40 °C (da 41° a 104°F)

Frequenze/Protocolli wireless 155 MHz a 32,77 dBm massimo, 2,4 GHz a -1,7 dBm massimo
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Collar para perros TT™ 15X/TT 15 mini
Guía de inicio rápido

Inicio
 ADVERTENCIA

Consulta la guía Información importante sobre el producto y tu seguridad que se incluye en la caja del producto y 
en la que encontrarás advertencias e información importante sobre el producto.

Dispositivo para collar de perros
NOTA: es posible que el collar para perros sea distinto al de la imagen.

Antena VHF

Antena GPS

Botón de encendido

Puntos de contacto

LED de estado y LED de localización intermitentes
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Encender el dispositivo
• Mantén pulsado el botón de encendido del collar para perros hasta que el LED de estado parpadee y el collar 

emita un pitido.

Apagar el dispositivo para collar de perros
Mantén pulsado el botón de encendido hasta que el LED de estado se ilumine en rojo fijo y el dispositivo 
emita un pitido.

Carga del collar para perros
AVISO

Para evitar la corrosión, seca bien los contactos del collar y el área circundante antes de conectar el clip 
cargador.

NOTA: es posible que el collar para perros sea distinto al de la imagen.
Debes cargar completamente la pila antes de utilizar el dispositivo por primera vez. Una batería totalmente 
descargada tarda aproximadamente cinco horas en cargarse.
1 Coloca el clip cargador  en el dispositivo .

2 Conecta el extremo pequeño del cable de alimentación al puerto mini-USB del cable del clip cargador.
3 Conecta el cable de alimentación a una fuente de alimentación.

El LED de estado permanece en rojo cuando el collar se está cargando.
4 Cuando el LED de estado se vuelva verde, quita el clip cargador del collar.

Buscar señales de satélite
Tanto el collar como el dispositivo de mano deben detectar señales de satélite antes de que le pongas el collar 
al perro. La detección de satélites puede tardar unos minutos.
1 Dirígete a un lugar al aire libre.
2 Enciende ambos dispositivos.

 en la barra de estado muestra la intensidad de la señal GPS.
Una vez que el collar ha detectado las señales de satélite, el LED de estado parpadea dos o tres veces 
emitiendo una luz verde.
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Añadir un perro en el dispositivo de mano Alpha mediante vinculación inalámbrica
1 Si el collar para perros está encendido, apágalo.
2 Mantén pulsado el botón de encendido del collar para perros hasta que emita dos series de pitidos (durante 

unos 2 segundos) y, a continuación, suéltalo.
El LED de estado parpadea rápidamente en verde. El collar para perros está listo para asociarse o vincularse 
a un dispositivo de mano.

3 En el dispositivo de mano, selecciona Lista de perros > Añadir perro.
4 Selecciona una opción:

• Si estás cerca del collar para perros, selecciona Vincular collar y sigue las instrucciones que aparecen en 
pantalla.

• Selecciona Recibir desde disp. mano para que el collar para perros se vincule recibiendo la información 
de otro dispositivo de mano.
NOTA: para vincular correctamente el dispositivo, el otro dispositivo de mano debe compartir de forma 
inalámbrica la información del collar para perros.

5 Tras añadir correctamente el collar para perros, introduce el nombre del perro y selecciona .

Seleccionar e instalar los puntos de contacto
 ATENCIÓN

Para evitar irritaciones en los puntos de contacto, quita el collar al menos ocho horas cada periodo de 24 horas.
No expongas el dispositivo o el collar a productos químicos agresivos, entre otros, productos para pulgas o 
garrapatas. Asegúrate siempre de que cualquier producto para pulgas o garrapatas que se aplique al perro se 
ha secado por completo antes de colocarle el collar. Los productos químicos agresivos, incluso en pequeñas 
cantidades, pueden dañar los componentes plásticos y el laminado del collar.

Para obtener un resultado óptimo, selecciona los puntos de contacto correctos de acuerdo con el pelaje del 
perro.
1 Selecciona la longitud del punto de contacto de acuerdo con el tipo de pelaje del perro:

• Utiliza puntos de contacto más largos en perros con un pelaje más espeso.
• Utiliza puntos de contacto más cortos en perros con un pelaje menos espeso.

2 Si es necesario, utiliza la llave incluida para retirar los puntos de contacto.
3 Gira los puntos de contacto para insertarlos en el collar.
4 Ajústalos con la llave incluida sin llegar a apretarlos en exceso.
Cuando le coloques el collar al perro, asegúrate de que los puntos de contacto están bien ajustados en el 
cuello.
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Colocación del collar en el perro
 ATENCIÓN

Para evitar irritaciones en los puntos de contacto, quita el collar al menos ocho horas cada periodo de 24 horas.
Este dispositivo no está diseñado para su uso en humanos. No intentes utilizarlo en ninguna persona.
No expongas el dispositivo o el collar a productos químicos agresivos, entre otros, productos para pulgas o 
garrapatas. Asegúrate siempre de que cualquier producto para pulgas o garrapatas que se aplique al perro se 
ha secado por completo antes de colocarle el collar. Los productos químicos agresivos, incluso en pequeñas 
cantidades, pueden dañar los componentes plásticos y el laminado del collar.

Para adiestrar al perro de forma efectiva, el collar y el dispositivo se le deben colocar de la forma correcta. Si el 
collar está muy suelto o se coloca de forma incorrecta, la estimulación no se realizará de una forma coherente. 
Esto puede provocar que el adiestramiento se retrase o no se realice de forma adecuada.
1 Coloca el dispositivo en la parte delantera del cuello del perro, con el LED de estado apuntando hacia el 

mentón y los puntos de contacto hacia la garganta.
2 Aprieta la correa hasta que quede ajustada al cuello del perro y abrocha el cierre.

NOTA: el collar debe quedar bien ajustado y no girarse ni deslizarse en el cuello. Debe permitir que el perro 
trague el agua y la comida con normalidad. Observa el comportamiento del perro para asegurarte de que el 
collar no esté demasiado apretado.

3 Curva el dispositivo para que los puntos de contacto atraviesen el pelaje del perro.
NOTA: los puntos de contacto deben tocar la piel del perro para que resulten eficaces.

4 Si la correa es demasiado larga, corta el exceso, dejando al menos 8 cm (3 in) de sobra.
SUGERENCIA: puedes marcar el agujero que utilizas para abrochar el cierre para localizarlo posteriormente.

Rastreo y adiestramiento de perros
Un dispositivo de mano puede rastrear varios collares para perros y otros dispositivos de mano.

Realizar el seguimiento de perros
El dispositivo de mano te permite realizar el seguimiento de la posición de uno o varios perros a través de la 
brújula de seguimiento o el mapa. El mapa muestra tu ubicación, así como la ubicación y los tracks del perro. El 
puntero de la brújula indica la dirección de la ubicación actual del perro.
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Adiestramiento de perros
AVISO

Debes documentarte e investigar los métodos de adiestramiento que mejor se adapten a ti, a tu perro y a 
vuestras necesidades. En este manual se facilitan algunas directrices básicas para el adiestramiento, pero cada 
perro posee unas necesidades de adiestramiento únicas.
Si se usa correctamente, el sistema de adiestramiento Alpha es una herramienta de adiestramiento muy eficaz 
que ayudará a tu perro a alcanzar su máximo potencial. El uso del sistema de adiestramiento debería formar 
parte de un programa de adiestramiento más amplio.

Comienza a adiestrar a tu perro con una correa, sin el sistema de adiestramiento Alpha . Debes enseñar a tu 
perro a que te siga, se siente y acuda a tu llamada. Una vez que el perro entienda estas tres órdenes básicas, 
podrás comenzar a adiestrarlo con el collar para perros y la correa. Por último, cuando el perro obedezca por 
norma general las órdenes con la correa y el collar, puedes quitarle la correa para adiestrarlo únicamente con el 
collar para perros.

Comunicación con el collar
Debes mantener una línea de visión sin obstáculos entre el dispositivo de mano y el collar del perro para que la 
señal de comunicación sea óptima. Para lograr una línea de visión óptima, debes dirigirte al punto más elevado 
de tu zona (por ejemplo, la parte más alta de una cuesta).

Óptima

Buena

Deficiente

Acceder al modo suspensión
NOTA: esta función no está disponible para todos los modelos de collar para perros.
Para poder acceder al modo suspensión, primero debes realizar un seguimiento de la ubicación del perro con el 
collar para perros compatible.
Al conectarlo con el dispositivo de mano, el collar para perros se puede poner en modo suspensión para ahorrar 
energía si no estás realizando el seguimiento del perro.
1 Selecciona Lista de perros.
2 Selecciona un perro.
3 Selecciona  > Ajustar modo suspen. collar > Suspensión.
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Salir del modo suspensión
NOTA: esta función no está disponible para todos los modelos de collar para perros.
Puedes salir del modo suspensión en el collar para perros compatible cuando no estés realizando el 
seguimiento del perro.
1 Selecciona Lista de perros.
2 Selecciona un perro.
3 Selecciona  > Ajustar modo suspen. collar > Activación.

Información del dispositivo

Obtención del manual del usuario
Puedes descargar la versión más reciente del manual del usuario de Internet.
1 Visita www.garmin.com/support.
2 Selecciona Manuales.
3 Sigue las instrucciones que aparecen en pantalla para seleccionar el producto.

Actualizar el software del dispositivo para collar de perros
Antes de poder actualizar el software del dispositivo para collar de perros, debes conectar el dispositivo para 
collar de perros a un ordenador.
NOTA: solo desde un PC. Al actualizar el software no se borra ningún dato ni configuración.
1 Visita www.garmin.com/products/webupdater.
2 Sigue las instrucciones que se muestran en la pantalla.

Información de la radio VHF
Este producto solo se puede utilizar en radiofrecuencias específicas, que varían dependiendo del país donde se 
utilice. El dispositivo de mano y el dispositivo para perros permiten que el usuario instale una antena distinta. Si 
se cambia la antena, es posible que el rendimiento de la radio mejore y la potencia radiada sea mayor. Este 
dispositivo no debe utilizarse con una antena suministrada por terceros o que no esté aprobada por Garmin. 
Visita www.garmin.com/tracking-legal para obtener más información acerca del rendimiento y la 
radiofrecuencia de este producto, los accesorios aprobados y los límites de potencia en función del país.
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Fijación de la antena y del protector al collar
AVISO

Si usas bridas, asegúrate de que ningún borde afilado esté en contacto con la piel de tu perro.

Puedes fijar la antena y el protector al collar para perros para que este se adapte mejor a tu perro.
Para obtener el máximo rendimiento de la radio, la antena debe quedar recta hacia arriba al colocarse en el 
perro. Según el tamaño del cuello de tu perro, es posible que necesites bridas para colocar la antena 
adecuadamente.
1 Fija el protector de la antena  al collar con una de las bridas suministradas .

2 Fija la antena  al collar con una de las bridas suministradas .
3 Corta el exceso de las bridas si son demasiado largas.

Especificaciones del collar para perros
Tipo de pila/batería Ion-litio, recargable, sustituible, 361-00029-04

Rango de temperatura de funcionamiento De -20 °C a 60°C (de -4 °F a 140°F)

Rango de temperatura de carga De 0 °C a 40 °C (de 32 °F a 104 °F)

Protocolos y frecuencias inalámbricas 152-169 MHz a 24,2 dBm máximo, 2,4 GHz a 6,9 dBm máximo

SAR para la UE 0,06 W/kg simultáneos en el torso, 0,07 W/kg simultáneos en las 
extremidades

Especificaciones del collar para perros Mini
Tipo de pila/batería Ion-litio, recargable, sustituible, 361-00035-09

Rango de temperatura de funcionamiento De -20 °C a 60°C (de -4 °F a 140°F)

Rango de temperatura de carga De 5 °C a 40 °C (de 41 °F a 104 °F)

Protocolos/frecuencias inalámbricas 155 MHz a 32,77 dBm máximo, 2,4 GHz a -1,7 dBm máximo
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Obroża z nadajnikiem dla psa TT™ 15X/TT 15 mini
Skrócony podręcznik użytkownika

Rozpoczęcie pracy z urządzeniem
 OSTRZEŻENIE

Należy zapoznać się z zamieszczonym w opakowaniu produktu przewodnikiem Ważne informacje dotyczące 
bezpieczeństwa i produktu zawierającym ostrzeżenia i wiele istotnych wskazówek.
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Obroża z nadajnikiem dla psa
UWAGA: Posiadana obroża z nadajnikiem dla psa może wyglądać nieco inaczej niż zaprezentowane tutaj 
urządzenie.

Antena VHF

Antena GPS

Przycisk zasilania

Styki

Wskaźnik LED i migające sygnalizatory LED

Włączanie urządzenia
• Naciśnij i przytrzymaj przycisk zasilania obroży tak długo, aż zamiga jej dioda LED i usłyszysz sygnał 

dźwiękowy.

Wyłączanie obroży z nadajnikiem dla psa
Naciśnij i przytrzymaj przycisk zasilania tak długo, aż wskaźnik LED zaświeci się na czerwono i usłyszysz 
sygnał dźwiękowy.
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Ładowanie obroży psa
NOTYFIKACJA

Aby zapobiec korozji, należy dokładnie osuszyć styki i obszar wokół nich przed podłączeniem zaczepu do 
ładowania.

UWAGA: Posiadana obroża z nadajnikiem dla psa może wyglądać nieco inaczej niż zaprezentowane tutaj 
urządzenie.
Przed pierwszym użyciem urządzenia należy w pełni naładować baterię. Ładowanie całkowicie rozładowanej 
baterii trwa około 5 godzin.
1 Przymocuj zaczep do ładowania  do urządzenia .

2 Podłącz mniejszą wtyczkę przewodu zasilającego do portu mini-USB kabla z zaczepem do ładowania.
3 Podłącz przewód zasilający do źródła zasilania.

Podczas ładowania dioda LED stanu obroży świeci w sposób ciągły na czerwono.
4 Gdy dioda LED stanu zacznie świecić w sposób ciągły na zielono, odłącz zaczep do ładowania od obroży.

Odbieranie sygnałów satelitarnych
Tak obroża, jak i urządzenie przenośne muszą odebrać sygnały z satelitów zanim obroża zostanie założona psu 
na szyję. Odebranie sygnałów z satelitów może potrwać kilka minut.
1 Wyjdź na zewnątrz, na otwarty teren.
2 Włącz oba urządzenia.

 na pasku stanu pokazuje moc sygnału GPS.
Gdy obroża odbierze sygnały satelitarne, dioda LED zamiga dwa lub trzy razy na zielono.
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Dodawanie psa do urządzenia podręcznego Alpha za pomocą parowania bezprzewodowego
1 Jeśli obroża z nadajnikiem dla psa jest włączona, wyłącz ją.
2 Przytrzymaj przycisk zasilania, aż obroża z nadajnikiem dla psa wyemituje dwie serie sygnałów dźwiękowych 

(około 2 sekundy), a następnie puść przycisk zasilania.
Wskaźnik LED miga szybko na zielono. Obrożę z nadajnikiem dla psa można teraz połączyć (sparować) 
z urządzeniem podręcznym.

3 W urządzeniu podręcznym wybierz kolejno Lista psów > Dodaj psa.
4 Wybierz opcję:

• Jeśli znajdujesz się w pobliżu obroży z nadajnikiem dla psa, wybierz Sparuj obrożę i postępuj zgodnie 
z instrukcjami wyświetlanymi na ekranie.

• Aby sparować obrożę z nadajnikiem dla psa poprzez odbieranie informacji z innego urządzenia 
podręcznego, wybierz Odbierz z urz. podręcznego.
UWAGA: Aby urządzenie zostało pomyślnie sparowane, drugie urządzenie podręczne musi 
bezprzewodowo udostępniać informacje o obroży z nadajnikiem dla psa.

5 Po dodaniu obroży z nadajnikiem dla psa wpisz imię psa i wybierz .

Wybór i zakładanie styków
 PRZESTROGA

Aby zapobiec podrażnieniom w miejscach kontaktu, kołnierz należy zdjąć przynajmniej na 8 godzin w takcie 24-
godzinnego cyklu.
Nie wolno spryskiwać urządzenia środkami chemicznymi o silnym działaniu, takimi jak na przykład środki 
przeciw pchłom i kleszczom. Po zastosowaniu środka przeciw pchłom i kleszczom obrożę można założyć 
dopiero po całkowitym wyschnięciu sierści psa. Nawet małe ilości takich środków mogą uszkodzić plastikowe 
elementy i laminat obroży.

Aby uzyskać najlepsze wyniki, należy wybrać odpowiednie styki dostosowane do sierści psa.
1 Wybierz długość styków dopasowaną do sierści psa:

• W przypadku psów o grubszej sierści użyj dłuższych styków.
• W przypadku psów o krótszej sierści użyj krótszych styków.

2 W razie potrzeby użyj dostarczonego klucza w celu wyjęcia styków.
3 Wkręć styki w obrożę.
4 Dokręć je dostarczonym kluczem, ale nie używaj nadmiernej siły.
Po założeniu obroży na szyję psa sprawdź, czy styki przylegają do szyi.
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Zakładanie obroży psu
 PRZESTROGA

Aby zapobiec podrażnieniom w miejscach kontaktu, kołnierz należy zdjąć przynajmniej na 8 godzin w takcie 24-
godzinnego cyklu.
Urządzenie to nie jest przeznaczone do stosowania przez ludzi Nie wolno go używać na ludziach.
Nie wolno spryskiwać urządzenia środkami chemicznymi o silnym działaniu, takimi jak na przykład środki 
przeciw pchłom i kleszczom. Po zastosowaniu środka przeciw pchłom i kleszczom obrożę można założyć 
dopiero po całkowitym wyschnięciu sierści psa. Nawet małe ilości takich środków mogą uszkodzić plastikowe 
elementy i laminat obroży.

W celu efektywnego szkolenia psa należy prawidłowo założyć obrożę i urządzenie. Jeśli obroża jest za luźna lub 
nieprawidłowo umieszczona, stymulowanie zachowań może być niekonsekwentne. Może to opóźnić lub 
uniemożliwić skuteczne szkolenie.
1 Umieść urządzenie w przedniej części szyi psa w taki sposób, aby wskaźnik LED był skierowany w stronę 

pyska psa, a styki przylegały do jego gardła.
2 Zaciśnij pasek, tak aby dokładnie przylegał do szyi psa, i zapnij klamrę.

UWAGA: Obroża powinna dobrze przylegać i nie powinna się obracać ani przesuwać na szyi psa. Pies musi 
być w stanie swobodnie przełykać pokarm i wodę. Należy poobserwować zachowanie psa przez jakiś czas, 
aby stwierdzić, czy obroża nie jest za ciasna.

3 Poruszaj urządzeniem, aby styki przeszły przez sierść psa.
UWAGA: Aby styki działały, muszą mieć kontakt ze skórą psa.

4 Jeśli pasek jest za długi, odetnij nadwyżkę, zostawiając przynajmniej 8 cm (3 cale) zapasu.
PORADA: Można zaznaczyć otwór użyty do zapięcia klamry, co przyda się w przyszłości.

Trenowanie i śledzenie psów
Jedno urządzenie podręczne może monitorować wiele obroży z nadajnikiem dla psa i innych urządzeń 
podręcznych.
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Śledzenie psów
Urządzenie podręczne pozwala śledzić pozycję wielu psów za pomocą kompasu lub mapy. Na mapie 
wyświetlane jest położenie właściciela i psa oraz ślad pozostawiony przez zwierzę. Wskaźnik kompasu 
pokazuje kierunek, w którym należy się udać, aby odnaleźć psa.

Szkolenie psa
NOTYFIKACJA

Właściciel psa powinien zapoznać się z dostępnymi informacjami o metodach szkolenia i przeanalizować, która 
z nich jest najlepiej dopasowana do jego potrzeb i do samego psa. Ten dokument przedstawia podstawowe 
wskazówki dotyczące szkolenia. Jednak należy pamiętać, że każdy pies ma inne potrzeby szkoleniowe.
Prawidłowo używany system szkoleniowy Alpha jest bardzo skutecznym narzędziem umożliwiającym 
wykorzystanie całego potencjału psa. Omawiany system szkoleniowy powinien stanowić element 
kompleksowego programu szkoleniowego.

Na początku szkolenia pies powinien być prowadzony na smyczy, bez systemu szkoleniowego Alpha . Należy 
nauczyć psa spacerować przy nodze właściciela, siadać i przybiegać na zawołanie. Gdy pies nauczy się tych 
trzech podstawowych poleceń, można zacząć szkolenie wykorzystujące obrożę elektroniczną i smycz. Gdy pies 
będzie konsekwentnie wykonywał polecenia z założoną obrożą i smyczą, można zdjąć smycz i prowadzić 
szkolenie tylko z założoną obrożą elektroniczną.

Sposób komunikacji z obrożą
Najlepszy sygnał komunikacyjny uzyskuje się, gdy na linii widzenia między urządzeniem ręcznym a obrożą psa 
nie ma żadnych przeszkód. W celu uzyskania najlepszych warunków na linii widzenia należy ustawić się na 
najwyższym w okolicy punkcie terenu (np. na szczycie wzniesienia).

Najlepszy

Dobry

Słaby

Włączanie trybu uśpienia
UWAGA: Funkcja nie jest dostępna we wszystkich modelach obroży elektronicznych.
Przed włączeniem trybu uśpienia należy ustalić pozycję psa za pomocą zgodnej obroży elektronicznej.
Po nawiązaniu połączenia z urządzeniem podręcznym obrożę można przełączyć w tryb uśpienia w celu 
oszczędzania energii baterii, gdy śledzenie psa nie jest akurat konieczne.
1 Wybierz Lista psów.
2 Wybierz psa.
3 Wybierz kolejno  > Dostosuj tryb uśp. obroży > Uśpij.
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Wyłączanie trybu uśpienia
UWAGA: Funkcja nie jest dostępna we wszystkich modelach obroży elektronicznych.
Możesz wyłączyć tryb uśpienia w obroży elektronicznej, gdy śledzenie psa nie jest akurat konieczne.
1 Wybierz Lista psów.
2 Wybierz psa.
3 Wybierz kolejno  > Dostosuj tryb uśp. obroży > Wybudź.

Informacje o urządzeniu

Pobieranie podręcznika użytkownika
Najnowszą wersję podręcznika użytkownika można pobrać ze strony internetowej.
1 Odwiedź stronę www.garmin.com/support.
2 Wybierz Podręczniki użytkownika.
3 Postępuj zgodnie z wyświetlanymi instrukcjami, aby wybrać swój produkt.

Aktualizacja oprogramowania obroży z nadajnikiem dla psa
Przed przeprowadzeniem aktualizacji oprogramowania obroży z nadajnikiem dla psa należy podłączyć ją do 
komputera.
UWAGA: tylko komputer stacjonarny. Aktualizacja oprogramowania nie spowoduje usunięcia żadnych danych 
ani ustawień.
1 Odwiedź stronę www.garmin.com/products/webupdater.
2 Wykonaj instrukcje wyświetlane na ekranie.

Informacje o radiu VHF
Urządzenie to korzysta ze ściśle określonych częstotliwości radiowych, które różnią się w zależności od kraju 
użytkowania produktu. Urządzenie ręczne i nadajnik mają możliwość zainstalowania innej anteny przez 
użytkownika. Zmiana anteny może poprawić działanie komunikacji radiowej oraz zapewnić silniejszy sygnał 
nadawania. Urządzenia nie można używać z anteną innego producenta ani z anteną, która nie została 
zatwierdzona przez firmę Garmin. Odwiedź stronę www.garmin.com/tracking-legal, aby uzyskać informacje na 
temat działania tego produktu i używanej przez niego częstotliwości radiowej, a także oryginalnych akcesoriów 
i ograniczeń mocy nadajników obowiązujących w poszczególnych krajach.
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Mocowanie anteny i szlufki anteny do obroży
NOTYFIKACJA

Używając opasek zaciskowych, upewnij się, że żadne ostre krawędzie nie dotykają skóry psa.

Możesz przymocować antenę i szlufkę anteny do obroży, aby dokładniej dopasować urządzenie do obroży psa.
Aby zapewnić maksymalną wydajność radia, zamontowana antena powinna być skierowana prosto do góry. 
W zależności od grubości szyi psa, może być konieczne użycie opasek zaciskowych, aby prawidłowo umieścić 
antenę.
1 Przymocuj szlufkę anteny  do obroży za pomocą jednej z dołączonych opasek zaciskowych .

2 Przymocuj antenę  za pomocą jednej z dołączonych opasek zaciskowych .
3 Odetnij nadmiar opaski zaciskowej.

Dane techniczne obroży elektronicznej
Typ baterii Ładowna, wymienna litowo-jonowa, 361-00029-04

Zakres temperatury roboczej Od -20°C do 60°C (od -4°F do 140°F)

Zakres temperatury ładowania Od 0°C do 40°C (od 32°F do 104°F)

Częstotliwości/protokoły bezprze­
wodowe

152–169 MHz przy 24,2 dBm (maksimum), 2,4 GHz przy 6,9 dBm 
(maksimum)

EU SAR 0,06 W/kg — tułów, równocześnie; 0,07 W/kg — kończyna, równocześnie

Dane techniczne obroży elektronicznej Mini
Typ baterii Ładowna, wymienna litowo-jonowa, 361-00035-09

Zakres temperatury roboczej Od -20°C do 60°C (od -4°F do 140°F)

Zakres temperatury ładowania Od 5°C do 40°C (od 41°F do 104°F)

Częstotliwości/protokoły bezprzewo­
dowe

155 MHz przy 32,77 dBm (maksimum), 2,4 GHz przy -1,7 dBm 
(maksimum)
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Psí obojek TT™ 15X/TT 15 mini
Stručný návod k obsluze

Začínáme
 VAROVÁNÍ

Přečtěte si leták Důležité bezpečnostní informace a informace o produktu vložený v obalu s výrobkem. Obsahuje 
varování a další důležité informace.

Psí obojek
POZNÁMKA: Váš psí obojek může vypadat jinak než obojek na obrázku.

Anténa VHF

Anténa GPS

Zapínací tlačítko

Kontaktní body

Stavová kontrolka a blikající majáková kontrolka
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Zapnutí zařízení
• Na obojku podržte stisknuté zapínací tlačítko, dokud nezačne blikat kontrolka stavu a obojek nezapípá.

Vypnutí obojku
Přidržte zapínací tlačítko, dokud nebude stavová kontrolka červeně svítit a zařízení nezapípá.

Nabíjení psího obojku
OZNÁMENÍ

Aby nedocházelo ke korozi, osušte důkladně kontakty na obojku a okolní oblast předtím, než připojíte nabíjecí 
klip.

POZNÁMKA: Váš psí obojek může vypadat jinak než obojek na obrázku.
Než obojek poprvé použijete, je nutné plně nabít baterii. Nabíjení zcela vybité baterie trvá přibližně pět hodin.
1 Nacvakněte nabíjecí klip  na obojek .

2 Zasuňte menší koncovku napájecího kabelu do portu mini-USB kabelu s nabíjecím klipem.
3 Připojte nabíjecí kabel k napájecímu zdroji.

Při nabíjení obojku bude stavová kontrolka svítit červeně.
4 Jakmile začne stavová kontrolka svítit zeleně, nabíjecí klip od obojku odpojte.

Vyhledání satelitních signálů
Obojek i přenosné zařízení musí navázat satelitní spojení předtím, než dáte obojek psovi na krk. Příjem 
satelitních signálů může trvat několik minut.
1 Vezměte přístroj ven, do otevřené krajiny.
2 Zapněte obě zařízení.

 ve stavové liště udává sílu signálu GPS.
Jakmile obojek naváže satelitní spojení, kontrolka stavu dvakrát nebo třikrát zeleně zabliká.
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Přidání psa do přenosného zařízení Alpha pomocí bezdrátového párování
1 Je-li psí obojek zapnutý, vypněte jej.
2 Přidržte zapínací tlačítko na obojku, dokud neuslyšíte dvě sady pípnutí (přibližně 2 sekundy). Poté tlačítko 

uvolněte.
Kontrolka stavu rychle zeleně bliká. Nyní je obojek psa připraven k propojení či spojení s přenosným 
zařízením.

3 Na přenosném zařízení zvolte Seznam psů > Přidat psa.
4 Vyberte možnost:

• Pokud jste v blízkosti obojku, vyberte možnost Spárovat obojek a postupujte podle pokynů na obrazovce.
• Chcete-li spárovat obojek pomocí údajů získaných z jiného přenosného zařízení, vyberte možnost 

Přijmout z handheldu.
POZNÁMKA: Aby bylo zařízení možné spárovat, musí druhé přenosné zařízení bezdrátově sdílet 
informace o obojku psa.

5 Po úspěšném přidání obojku psa zadejte jméno psa a potvrďte tlačítkem .

Výběr a instalace kontaktních bodů
 UPOZORNĚNÍ

Abyste zabránili podrážení způsobenému kontaktními body, sundávejte obojek vždy alespoň na osm hodin 
z každých 24.
Na zařízení ani obojek nestříkejte agresivní chemikálie, mezi které patří mimo jiné sprej proti blechám a 
klíšťatům. Vždy, než psovi nasadíte obojek, zkontrolujte, že použitý sprej proti blechám či klíšťatům již zcela 
zaschl. Malé množství agresivní chemikálie může poškodit umělohmotné a laminátové části obojku.

Nejlepších výsledků dosáhnete, zvolíte-li kontaktní body, které jsou nejvhodnější pro kožich psa.
1 Vyberte vhodnou délku kontaktního bodu podle typu kožichu svého psa:

• Pro psy s delší srstí zvolte delší kontaktní body.
• Pro psy s kratší srstí zvolte kratší kontaktní body.

2 Je-li třeba, použijte při odstraňování kontaktních bodů dodaný klíč.
3 Našroubujte kontaktní body do obojku.
4 Utáhněte je dodaným klíčem, avšak ne příliš.
Když obojek psovi nasadíte, zkontrolujte, že psovi kontaktní body pevně přiléhají ke krku.
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Jak psovi nasadit obojek
 UPOZORNĚNÍ

Abyste zabránili podrážení způsobenému kontaktními body, sundávejte obojek vždy alespoň na osm hodin 
z každých 24.
Toto zařízení není určeno k používání na lidech. V žádném případě jej nepoužívejte na osobách.
Na zařízení ani obojek nestříkejte agresivní chemikálie, mezi které patří mimo jiné sprej proti blechám a 
klíšťatům. Vždy, než psovi nasadíte obojek, zkontrolujte, že použitý sprej proti blechám či klíšťatům již zcela 
zaschl. Malé množství agresivní chemikálie může poškodit umělohmotné a laminátové části obojku.

Aby byl výcvik psa účinný, musí obojek psovi důkladně pasovat. Je-li obojek příliš volný nebo nesprávně 
umístěn, může být stimulace nekonzistentní. To může zdržovat úspěch při výcviku, nebo mu bránit.
1 Umístěte zařízení obojku zepředu psího krku, přičemž stavová kontrolka směřuje k bradě psa a kontaktní 

body proti krku.
2 Utáhněte pásek tak, aby obepínal krk psa velmi těsně, a zapněte přezku.

POZNÁMKA: Obojek musí být utažen do té míry, aby se nemohl otáčet ani psovi klouzat po krku. Psovi však 
musí umožňovat normálně polykat a pít. Zaměřte se na chování psa, abyste se ubezpečili, že obojek není 
utažen příliš.

3 Zakruťte obojkem, aby kontaktní body pronikly kožichem psa.
POZNÁMKA: Aby byly účinné, musí být kontaktní body ve styku s kůží psa.

4 Je-li pásek příliš dlouhý, přebytečnou část uřízněte tak, aby zůstalo přečnívat alespoň 8 cm (3 palce) pásku.
TIP: Abyste si usnadnili příští použití, můžete označit otvor, který jste použili k utažení přezky.

Sledování a výcvik psů
Jedno přenosné zařízení dokáže sledovat více obojků a dalších přenosných zařízení.

Sledování psů
Přenosné zařízení vám umožňuje sledovat psa nebo více psů pomocí sledovacího kompasu nebo mapy. Mapa 
zobrazuje vaši polohu i polohu vašeho psa a provádí sledování. Šipka kompasu ukazuje ve směru aktuální 
polohy psa.
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Výcvik psa
OZNÁMENÍ

Je třeba, abyste vyhledali a prověřili výcvikové metody, které nejlépe vyhovují vám, vašemu psovi a vašim 
potřebám. Tato příručka poskytuje základní pravidla výcviku, ale každý pes má jedinečné výcvikové potřeby.
Pokud je výcvikový systém Alpha vhodně aplikován, stává se velmi efektivním výcvikovým nástrojem, který 
pomůže vašemu psu plně rozvinout potenciál. Tento výcvikový systém by měl být součástí celkového 
výcvikového programu.

Začněte svého psa cvičit na vodítku, bez výcvikového systému Alpha . Měli byste psa naučit povel k noze, sedni 
a ke mně. Jakmile pes rozumí těmto třem základním povelům, můžete jej začít cvičit pomocí obojku se 
zařízením a vodítka. A konečně, jakmile pes konzistentně plní povely na vodítku s využitím obojku, můžete 
vodítko odepnout a psa cvičit pouze s použitím obojku se zařízením.

Komunikace s obojkem
Aby byl komunikační signál co nejlepší, neměly by se v přímé linii mezi vaším přenosným zařízením a obojkem 
psa nacházet žádné překážky. Aby byly podmínky pro zachování zorného pole co nejlepší, přesuňte se na 
nejvyšší místo ve své oblasti (například na kopec).

Nejlepší

Dobré

Špatné

Přechod do režimu spánku
POZNÁMKA: Tato funkce není k dispozici u všech modelů psích obojků.
Než budete moct přejít do režimu spánku, musíte pomocí kompatibilního psího obojku vysledovat polohu psa.
Když je psí obojek připojen k přenosnému zařízení, můžete jej přepnout do režimu spánku, abyste šetřili baterii, 
když právě psa aktivně nesledujete.
1 Vyberte možnost Seznam psů.
2 Vyberte psa.
3 Vyberte  > Upravit rež. spánku obojku > Režim spánku.
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Ukončení režimu spánku
POZNÁMKA: Tato funkce není k dispozici u všech modelů psích obojků.
Máte možnost ukončit režim spánku na kompatibilním psím obojku, když právě svého psa aktivně nesledujete.
1 Vyberte možnost Seznam psů.
2 Vyberte psa.
3 Vyberte  > Upravit rež. spánku obojku > Probudit.

Informace o zařízení

Získání návodu k obsluze
Nejnovější návod k obsluze můžete získat z webových stránek.
1 Přejděte na stranu www.garmin.com/support.
2 Vyberte možnost Návody.
3 Při výběru produktu se řiďte pokyny na obrazovce.

Aktualizace softwaru obojku pro psa
Pokud chcete aktualizovat software obojku pro psa, musíte obojek připojit k počítači.
POZNÁMKA: Pouze počítače PC. Aktualizací softwaru nevymažete žádná vlastní data ani nastavení.
1 Přejděte na webovou stránku www.garmin.com/products/webupdater.
2 Postupujte podle pokynů na obrazovce.

Informace o vysílání VHF
Tento produkt je povoleno používat pouze v určitých vysílacích pásmech, která se liší v závislosti na zemi 
použití. Přenosné zařízení a modul pro psa umožňují, aby v nich uživatel nainstaloval jinou anténu. Výměna 
antény může způsobit vyšší výkon vysílání a silnější záření. Je zakázáno používat zařízení s anténou třetí strany 
nebo s anténou, kterou neschválila společnost Garmin. Na webové stránce www.garmin.com/tracking-legal 
naleznete podrobnosti o výkonu a rádiových frekvencích tohoto produktu, povoleném příslušenství a omezení 
záření v různých zemích.

Připevnění antény a chrániče antény k obojku
OZNÁMENÍ

Při použití vázacích pásek zajistěte, aby ostré hrany nebyly v kontaktu s kůží psa.

Anténu a chránič antény můžete připevnit k obojku, čímž dosáhnete optimálního seřízení obojku pro konkrétního 
psa.
Pro maximální výkon vysílání by měla anténa po umístění na psa směřovat přímo vzhůru. V závislosti na 
velikosti krku psa možná budete ke správnému umístění antény potřebovat vázací pásky.
1 Připevněte chránič antény  k obojku pomocí jedné z dodaných vázacích pásek .

2 Připevněte anténu  k obojku pomocí jedné z dodaných vázacích pásek .
3 Odstřihněte nadbytečnou délku vázacích pásek.
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Specifikace obojku
Typ baterie Dobíjecí, vyměnitelná lithium-iontová, 361-00029-04

Rozsah provozních teplot -20 až 60 °C (-4 až 140 °F)

Rozsah nabíjecí teploty 0 až 40 °C (32 až 104 °F)

Bezdrátové frekvence/protokoly 152–169 MHz při maximální hodnotě 24,2 dBm, 2,4 GHz při maximální 
hodnotě 6,9 dBm

EU SAR Trup: 0,06 W/kg – simultánní přenos, končetiny: 0,07 W/kg – simultánní 
přenos

Specifikace obojku Mini
Typ baterie Dobíjecí, vyměnitelná lithium-iontová, 361-00035-09

Rozsah provozních teplot -20 až 60 °C (-4 až 140 °F)

Rozsah nabíjecí teploty 5 až 40 °C (41 až 104 °F)

Bezdrátové frekvence/protokoly 155 MHz při maximální hodnotě 32,77 dBm, 2,4 GHz při maximální hodnotě 
-1,7 dBm
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Устройство для собачьего ошейника TT™ 15X/TT 15 mini
Краткое руководство по эксплуатации

Начало работы
 ОСТОРОЖНО

Сведения о безопасности и другую важную информацию см. в руководстве Правила техники 
безопасности и сведения об изделии, которое находится в упаковке изделия.

Устройство для собачьего ошейника
ПРИМЕЧАНИЕ. устройство для собачьего ошейника может отличаться от изображенного на рисунке.

VHF-антенна

GPS-антенна

Кнопка питания

Контактные точки

Индикатор состояния и мигающий сигнальный индикатор
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Включение устройства
• На устройстве для собачьего ошейника нажмите и удерживайте кнопку питания до тех пор, пока 

индикатор состояния не начнет мигать, а ошейник не издаст сигнал.

Отключение устройства «Собачий ошейник»
Нажмите и удерживайте кнопку питания до тех пор, пока светодиодный индикатор состояния не 
начнет постоянно светиться красным, а устройство начнет издавать звуковые сигналы.

Зарядка устройства для собачьего ошейника
УВЕДОМЛЕНИЕ

Для предотвращения коррозии перед подключением зарядного зажима тщательно высушите контакты 
на ошейнике и прилегающие области.

ПРИМЕЧАНИЕ. устройство для собачьего ошейника может отличаться от изображенного на рисунке.
Перед первым использованием устройства необходимо полностью зарядить аккумулятор. Зарядка 
полностью разряженного аккумулятора занимает около пяти часов.
1 Закрепите зарядный зажим  на устройстве .

2 Подключите меньший разъем кабеля питания к порту mini-USB на кабеле зарядного зажима.
3 Подключите кабель к источнику питания.

Во время зарядки ошейника индикатор состояния, не мигая, горит красным.
4 Когда цвет индикатора состояния сменится на зеленый, снимите зарядный зажим с ошейника.

Установление связи со спутниками
Прежде чем надевать ошейник на собаку, убедитесь, что и ошейник, и пульт управления получают 
сигналы со спутников. Установление связи со спутниками может занять несколько минут.
1 Выйдите на открытое место вне помещения.
2 Включите оба устройства .

Значок  в строке состояния показывает мощность сигнала GPS.
Когда ошейник установит связь со спутниками, светодиодный индикатор состояния мигнет зеленым 
дважды или трижды.
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Добавление собаки в пульт управления Alpha с помощью беспроводного сопряжения
1 Если устройство для собачьего ошейника включено, отключите его.
2 Удерживайте кнопку питания на устройстве для собачьего ошейника, пока оно не издаст две серии 

звуковых сигналов (около 2 секунд), затем отпустите кнопку питания.
Индикатор состояния быстро замигает зеленым цветом. Устройство для собачьего ошейника 
готово для привязки или сопряжения с пультом управления.

3 На пульте управления выберите Список собак > Добавление собаки.
4 Выберите один из следующих вариантов:

• Если вы находитесь рядом с устройством для собачьего ошейника, нажмите Сопряжение 
ошейника и следуйте инструкциям на экране.

• Чтобы выполнить сопряжение устройства для собачьего ошейника путем получения информации 
с другого пульта управления, выберите Прием с пульта управ..
ПРИМЕЧАНИЕ. для выполнения сопряжения устройства другой пульт управления должен 
передавать информацию об устройстве для собачьего ошейника по беспроводной сети.

5 Добавив устройство для собачьего ошейника, введите кличку собаки и нажмите .

Выбор и установка контактных точек
 ВНИМАНИЕ

Во избежание раздражения от контактных точек, снимайте ошейник как минимум на восемь часов в 
сутки.
Не распыляйте на устройство или ошейник агрессивные химические вещества, включая, но не 
ограничиваясь, спреи от блох или клещей. Перед тем как надеть ошейник на собаку, следует убедиться, 
что нанесенный на нее спрей от блох или клещей полностью высох. Небольшое количество 
агрессивных химических веществ может привести к повреждению пластмассовых деталей и подложки 
ошейника.

Для получения оптимальных результатов необходимо выбрать правильные контактные точки, исходя 
из типа шерсти собаки.
1 Выберите соответствующую длину контактной точки с учетом типа шерсти собаки:

• Для собаки с густой шерстью выберите длинные контактные точки.
• Для собаки с короткой шерстью выберите более короткие контактные точки.

2 При необходимости для извлечения контактных точек можно использовать ключ, входящий в 
комплект поставки.

3 Вставьте контактные точки в ошейник.
4 Затяните при помощи ключа, входящего в комплект поставки, но не перетягивайте.
Надевая ошейник на собаку, убедитесь, что контактные точки плотно прилегают к шее.
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Регулировка длины ошейника
 ВНИМАНИЕ

Во избежание раздражения от контактных точек, снимайте ошейник как минимум на восемь часов в 
сутки.
Устройство не предназначено для использования на человеке. Не пытайтесь использовать его на 
человеке.
Не распыляйте на устройство или ошейник агрессивные химические вещества, включая, но не 
ограничиваясь, спреи от блох или клещей. Перед тем как надеть ошейник на собаку, следует убедиться, 
что нанесенный на нее спрей от блох или клещей полностью высох. Небольшое количество 
агрессивных химических веществ может привести к повреждению пластмассовых деталей и подложки 
ошейника.

Для эффективной дрессировки собаки ошейник и устройство должны быть правильно закреплены на 
ней. Если ошейник слабо затянут или расположен неправильно, то стимуляция может срабатывать с 
перебоями. В результате собака не научится или нескоро научится не лаять.
1 Устройство должно находиться спереди над грудью собаки, светодиодный индикатор должен быть 

направлен в сторону подбородка, а контактные точки — соприкасаться с горлом животного.
2 Затяните ошейник так, чтобы он плотно облегал шею, закрепите ремешок.

ПРИМЕЧАНИЕ. ошейник должен сидеть плотно, не должен прокручиваться или соскальзывать. При 
этом собака должна спокойно глотать пищу и воду. Проследите за поведением собаки и убедитесь, 
что ошейник затянут не слишком сильно.

3 Слегка подвигайте устройство так, чтобы контактные точки касались кожи сквозь шерсть 
животного.
ПРИМЕЧАНИЕ. для эффективной работы контактные точки должны соприкасаться с кожей собаки.

4 Если ремешок слишком длинный, отрежьте излишек, оставив свободный конец длиной не менее 
8 см (3 дюйма).
СОВЕТ. чтобы облегчить закрепление ремешка в будущем, отверстие, в которое продето крепление, 
можно отметить маркером.
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Отслеживание и дрессировка собаки
На одном пульте управления можно отслеживать несколько устройств для собачьего ошейника и 
другие пульты управления.

Отслеживание собаки
Пульт управления показывает местоположение собаки или нескольких собак, используя 
отслеживающий компас или карту. На карте отображается ваше местоположение, положение собаки и 
треки. Указатель компаса показывает направление текущего местоположения собаки.

Дрессировка собаки
УВЕДОМЛЕНИЕ

Выбор методов дрессировки определяется особенностями собаки и целями ее владельца. Данное 
руководство содержит некоторые базовые принципы дрессировки, однако потребности каждой собаки 
уникальны.
При правильном использовании система Alpha станет высокоэффективным средством обучения, 
которое поможет раскрыть потенциал собаки в полной мере. Систему следует использовать как 
дополнение к общей программе дрессировки.

Изначально дрессировку собаки следует проводить на поводке и без использования обучающей 
системы Alpha . Собака должна научиться таким командам, как "Рядом!", "Сидеть!" и "Ко мне!". После 
того как собака научится выполнять эти три базовые команды, можно приступать к ее дрессировке с 
использованием устройства для собачьего ошейника и поводка. Когда собака будет беспрекословно 
выполнять команды на поводке, его можно будет отцепить и приступить к дрессировке с 
использованием только устройства для ошейника.

Радиосвязь с ошейником
Максимальное качество сигналов достигается при отсутствии препятствий на линии прямой 
видимости между пультом управления и ошейником. Для улучшения качества связи между 
устройствами рекомендуется подняться на самую высокую точку в данной местности (например, на 
вершину холма).

Лучшее

Хорошо

Плохо

Краткое руководство по эксплуатации 49



Переход в режим ожидания
ПРИМЕЧАНИЕ. эта функция поддерживается не на всех устройствах для собачьего ошейника.
Спящий режим доступен при отслеживании местоположения собаки с помощью устройства для 
собачьего ошейника.
При установленном подключении к пульту управления устройство для собачьего ошейника можно 
перевести в спящий режим, чтобы сохранить заряд батареи, когда вы активно не следите за собакой.
1 Выберите Список собак.
2 Выберите собаку.
3 Выберите  > Настр. спящ. реж. ошейн. > Спящий режим.

Выход из режима ожидания
ПРИМЕЧАНИЕ. эта функция поддерживается не на всех устройствах для собачьего ошейника.
Когда вы активно не следите за собакой, можно отключить спящий режим на совместимом устройстве 
для собачьего ошейника.
1 Выберите Список собак.
2 Выберите собаку.
3 Выберите  > Настр. спящ. реж. ошейн. > Активировать.

Информация об устройстве

Просмотр руководства пользователя
Вы можете найти актуальную версию руководства пользователя на веб-сайте.
1 Перейдите на веб-сайт www.garmin.com/support.
2 Выберите Руководства.
3 Выполните приведенные на экране инструкции по выбору устройства.

Обновление программного обеспечения устройства для собачьего ошейника
Перед обновлением программного обеспечения устройства для собачьего ошейника необходимо 
подключить его к компьютеру.
ПРИМЕЧАНИЕ. только для ПК. При обновлении программного обеспечения данные и настройки не 
удаляются.
1 Перейдите на веб-сайт www.garmin.com/products/webupdater.
2 Следуйте инструкциям на экране.

Информация о радиоустройстве VHF
Данное устройство можно использовать только на определенных радиочастотах, разрешенных в той 
стране, где оно эксплуатируется. Пульт управления и устройство для ошейника допускают установку 
другой антенны. Замена антенны может повысить рабочие характеристики радиосвязи и увеличить 
излучаемую мощность. Не следует использовать данное устройство с антеннами сторонних 
производителей или антеннами, не одобренными компанией Garmin. Для получения подробной 
информации о рабочих характеристиках и диапазоне радиочастот, поддерживаемом данным 
устройством, разрешенных аксессуарах и ограничениях по мощности для разных стран посетите веб-
сайт www.garmin.com/tracking-legal.
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Крепление антенны и держателя антенны к ошейнику
УВЕДОМЛЕНИЕ

При использовании кабельных стяжек необходимо убедиться, что их острые края не касаются кожи 
собаки.

Чтобы рациональнее разместить устройство для собачьего ошейника на собаке, можно закрепить на 
ошейнике антенну и держатель антенны.
Чтобы обеспечить наилучший прием радиосигналов, антенна должна быть направлена вертикально 
вверх при ее креплении на собаке. В зависимости от толщины шеи собаки для правильного 
размещения антенны могут потребоваться одна или две кабельные стяжки.
1 Закрепите держатель антенны  на ошейнике с помощью одной из кабельных стяжек , входящих 

в комплект.

2 Закрепите антенну  на ошейнике с помощью одной из кабельных стяжек , входящих в 
комплект.

3 Обрежьте излишки кабельных стяжек.

Технические характеристики устройства для собачьего ошейника
Тип батареи Аккумуляторная, литий-ионная, заменяемая, 361-00029-04

Диапазон рабочих температур От -20° до 60 °C (от -4° до 140 °F)

Диапазон температур для зарядки От 0 °C до 40 °C (от 32 °F до 104 °F)

Частоты и протоколы беспровод­
ного соединения

152–169 МГц при 24,2 дБм, максимальная, 2,4 ГГц при 6,9 дБм, 
максимальная

Значения SAR в ЕС 0,06 Вт/кг для туловища, 0,07 Вт/кг для конечностей

Технические характеристики устройства для собачьего ошейника Mini
Тип батареи Аккумуляторная, литий-ионная, заменяемая, 361-00035-09

Диапазон рабочих температур От -20° до 60 °C (от -4° до 140 °F)

Диапазон температур для зарядки От 5° до 40 °C (от 41° до 104 °F)

Частоты и протоколы беспроводного 
соединения

155 МГц при 32,77 дБм, максимальная, 2,4 ГГц при -1,7 дБм, 
максимальная
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TT™ 15X/TT 15 mini koera kaelarihmaseade
Kiirkäivituse juhend

Alustamine
 HOIATUS

Toote hoiatused ja muu olulise teabe leiad toote karbis olevast juhendist Tähtis ohutus- ja tootealane teave.

Koera kaelarihma seade
MÄRKUS. sinu koera kaelarihmaseade võib olla teistsugune kui pildil olev seade.

VHF-antenn

GPS-antenn

Toitenupp

Kontaktpunktid

Oleku LED-märgutuli ja vilkuvad LED-märgutuled
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Seadme sisselülitamine
• Hoia koera kaelarihma toitenuppu all seni, kuni kaelarihma oleku märgutuli hakkab vilkuma ja kostavad 

piiksud.

Koera kaelarihmaseadme väljalülitamine
Hoia toitenuppu all, kuni oleku märgutuli jääb pidevalt punaselt põlema ja seade teeb piiksu.

Koera kaelarihmaseadme laadimine
TEATIS

Korrosiooni vältimiseks kuivata enne laadimisklambri ühendamist kaelarihma klemmid ja ümbritseva ala 
põhjalikult.

MÄRKUS. sinu koera kaelarihm võib olla teistsugune kui pildil olev seade.
Enne seadme esmakordset kasutust tuleks aku täielikult täis laadida. Täiesti tühja aku laadimiseks kulub 
umbes viis tundi.
1 Lükka laadimisklamber  seadmele .

2 Ühenda toitekaabli väike ots laadimisklambri kaabli mini-USB-porti.
3 Ühenda toitekaabel toiteallikaga.

Kaelarihma laadimisel põleb oleku LED-märgutuli punaselt.
4 Kui oleku LED-märgutuli muutub roheliseks, eemalda laadimisklamber kaelarihmalt.

Satelliitsignaalide hankimine
Nii kaelarihm kui ka käsiseade peavad hankima satelliitsignaalid, enne kui paigaldad koerale kaelarihma. 
Satelliitide hankimine võtab natuke aega.
1 Mine lagedasse paika.
2 Lülita mõlemad seadmed sisse.

 olekuribal näitab GPS-signaali tugevust.
Kui kaelarihm on hankinud satelliitsignaalid, vilgub roheline oleku märgutuli kaks või kolm korda.
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Koera lisamine Alpha käsiseadmesse juhtmeta sidumise abi
1 Kui koera kaelarihm on sisse lülitatud, lülita kaelarihm välja.
2 Hoia koera kaelarihma toitenuppu all, kuni seade piiksub kaks korda (u 2 sekundit järjest) ja seejärel vabasta 

toitenupp.
Oleku märgutuli vilgub kiirelt roheliselt. Koera kaelarihm on nüüd valmis käsiseadmega ühendamiseks või 
sidumiseks.

3 Vali käsiseadmel Dog List > Add Dog.
4 Tee valik.

• Kui oled koera kaelarihma lähedal, vali Pair Collar ja järgi ekraanil kuvatavaid juhiseid.
• Koera kaelarihma sidumiseks teisest käsiseadmest saadud teabe abil vali Receive from Handheld.

MÄRKUS. et seadme sidumine õnnestuks, peab teine käsiseade jagama koera kaelarihma teavet juhtmeta 
ühenduse kaudu.

5 Kui koera kaelarihm on lisatud, sisesta koera nimi ja vali .

Kontaktpunktide valimine ja paigaldamine
 ETTEVAATUST

Kontaktpunktidest tingitud ärrituse vältimiseks eemalda kaelarihm vähemalt kaheksaks tunniks 24-st.
Ära pihusta seadmele ega kaelarihmale tugevatoimelisi kemikaale, sh (kui mitte ainult) kirbu- või puugisprei. 
Enne koerale kaelarihma paigaldamist veendu, et koerale pihustatud mis tahes kirbu- või puugisprei on täielikult 
kuivanud. Tugevatoimelise kemikaali väike kogus võib plastkomponente ja kaelarihma laminaatkihti kahjustada.

Parima tulemuse saamiseks vali õiged kontaktpunktid koera karvkatte põhjal.
1 Vali koera karvkattetüübi jaoks õige kontaktpunkti pikkus.

• Paksema karvkattega koera jaoks kasuta pikemaid kontaktpunkte.
• Lühema karvkattega koera jaoks kasuta lühemaid kontaktpunkte.

2 Vajaduse korral kasuta kontaktpunktide eemaldamiseks komplektis olevat võtit.
3 Keera kontaktpunktid kaelarihma külge.
4 Pinguta komplektis oleva võtmega, aga mitte liiga tugevalt.
Koerale kaelarihma kaela pannes veendu, et kontaktpunktid oleksid tihedalt vastu kaela.
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Kaelarihma sobitamine koerale
 ETTEVAATUST

Kontaktpunktidest tingitud ärrituse vältimiseks eemalda kaelarihm vähemalt kaheksaks tunniks 24-st.
Seade pole mõeldud inimkasutuseks. Ära proovi seda inimestel kasutada.
Ära pihusta seadmele ega kaelarihmale tugevatoimelisi kemikaale, sh (kui mitte ainult) kirbu- või puugisprei. 
Enne koerale kaelarihma paigaldamist veendu, et koerale pihustatud mis tahes kirbu- või puugisprei on täielikult 
kuivanud. Tugevatoimelise kemikaali väike kogus võib plastkomponente ja kaelarihma laminaatkihti kahjustada.

Koera tõhusaks treenimiseks peavad kaelarihm ja seade koerale korralikult sobima. Kui kaelarihm on liiga lõtv 
või valesti paigutatud, võib stimulatsioon olla ebaühtlane. See võib edukat treenimist edasi lükata või takistada.
1 Aseta seade koera kaela ette nii, et oleku LED-märgutuli oleks koera lõua poole ja kontaktpunktid kurgu 

vastas.
2 Pinguta rihma nii, et see oleks koeral tihedalt kaela ümber, ja kinnita pannal.

MÄRKUS. kaelarihm peaks tihedalt ümber kaela olema ega tohiks koera kaelal pöörelda ega libiseda. Koer 
peab suutma tavapäraselt toitu ja vett neelata. Peaksid koera käitumist jälgima veendumaks, et kaelarihm ei 
ole liiga tugevalt ümber kaela.

3 Liiguta seadet, et kontaktpunktide läheksid läbi koera karva.
MÄRKUS. kontaktpunktid peavad kokku puutuma koera nahaga, et need efektiivselt töötaksid.

4 Kui rihm on liiga pikk, lõika liigne osa ära, jättes varuks vähemalt 8 cm (3 tolli).
VIHJE: hilisemaks kasutamiseks võid märgistada pandla kinnitamiseks kasutatud augu.

Koera jälgimine ja treenimine
Üks käsiseade saab jälgida mitut koera kaelarihmaseadet ja muid käsiseadmeid.

Koera jälgimine
Käsiseade võimaldab sul oma koera või mitut koera jälgida jälgimiskompassi või kaardi abil. Kaart näitab sinu 
asukohta ning koera asukohta ja radasid. Kompassi osuti näitab koera praeguse asukoha suunas.
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Koera treenimine
TEATIS

Peaksid uurima treenimismeetodeid, mis sobivad kõige paremini sulle, sinu koerale ja sinu vajadustega. Selles 
käsiraamatus on välja toodud mõned põhijuhised treenimiseks, kuid igal koeral on ainulaadsed 
treenimisvajadused.
Õigesti kasutades on treeningsüsteem Alpha väga tõhus treenimise vahend, mis aitab sinu koeral oma 
potentsiaali täielikult ära kasutada. Treeningusüsteemi tuleks kasutada osana üldisest treeninguprogrammist.

Alusta koera treenimist rihma otsas ilma treeningsüsteemita Alpha . Peaksid oma koerale õpetama kõrval 
käimist, istumist ja sinu juurde tulemist. Peale seda, kui koer teab neid kolme põhikäsklust, saad alustada 
treenimist koera kaelarihmaseadme ja rihmaga. Lõpuks, kui koer täidab järjekindlalt rihma ja kaelarihma 
kasutades käsklusi, võid rihma eemaldada ning treenida ainult kaelarihmaseadmega.

Side kaelarihmaga
Parima sidesignaali saamiseks peaksid käsiseadme ja koera kaelarihmaseadme vahel takistusteta 
nägemisjoont hoidma. Parima nägemisjoone saavutamiseks peaksid liikuma oma piirkonna kõrgeimasse kohta 
(näiteks mäe otsas).

Parim

Hea

Halb

Unerežiimi sisenemine
MÄRKUS. seda funktsiooni ei saa kasutada koera kaelarihmaseadmete kõigil mudelitel.
Enne kui saad unerežiimi sisse lülitada, pead leidma koera asukoha, kasutades ühilduvat koera 
kaelarihmaseadet.
Kui koera kaelarihmaseade on käsiseadmega ühendatud, saab koera kaelarihmaseadme lülitada unerežiimile, et 
säästa akut, kui koera parajasti ei jälgita.
1 Vali Dog List.
2 Vali koer.
3 Vali  > Adjust Collar Sleep Mode > Sleep.
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Unerežiimist väljumine
MÄRKUS. seda funktsiooni ei saa koera kaelarihmaseadme kõigil mudelitel kasutada.
Koera ühilduvas kaelarihmaseadmes võib unerežiimist väljuda, kui koera parajasti ei jälgita.
1 Vali Dog List.
2 Vali koer.
3 Vali  > Adjust Collar Sleep Mode > Wake.

Seadme teave

Kasutusjuhendi hankimine
Uusima kasutusjuhendi leiad veebist.
1 Ava veebileht www.garmin.com/support.
2 Vali Juhendid.
3 Oma toote valimiseks järgi ekraanil kuvatavaid juhiseid.

Koera kaelarihmaseadme tarkvara uuendamine
Enne koera kaelarihmaseadme tarkvara uuendamist tuleb koera kaelarihmaseade ühendada arvutiga.
MÄRKUS. ainult arvutis. Tarkvara värskendamine ei kustuta sinu andmeid ega ühtki seadet.
1 Külasta veebilehte www.garmin.com/products/webupdater.
2 Järgi ekraanil kuvatavaid juhiseid.

VHF-raadio teave
Seda seadet võib kasutada ainult teatud raadiosagedustel, mis erinevad olenevalt riigist, kus seadet 
kasutatakse. Kasutaja saab käsi- ja koeraseadmele teistsuguse antenni paigaldada. Antenni vahetamisel võib 
raadio helikvaliteet paraneda ja kiirgusvõimsus suureneda. Seadmega ei peaks kasutama kolmanda isiku 
antenni või ettevõtte Garmin heakskiiduta antenni. Vaata lehelt www.garmin.com/tracking-legal lisateavet selle 
toote jõudluse ja raadiosageduse, seaduspäraste lisaseadmete ning riikide võimsuspiirangute kohta.

Antenni ja antennihoidiku kinnitamine kaelarihma külge
TEATIS

Kaablisidemete kasutamise korral veendu, et teravad servad ei puutu koera nahaga kokku.

Antenni ja antennihoidiku saab kinnitada kaelarihma külge, et optimeerida koera kaelarihmaseadme sobivust 
koerale.
Raadio maksimaalse jõudluse tagamiseks peab antenn koerale asetades olema suunatud otse üles. Olenevalt 
koera kaela suurusest pead võib-olla kasutama antenni õigeks paigutamiseks kaablisidemeid.
1 Kinnita antennihoidik  kaelarihma külge ühe komplekti kuuluva kaablisidemega .

2 Kinnita antenn  kaelarihma külge ühe komplekti kuuluva kaablisidemega .
3 Lõika kaablisideme liigne pikkus ära.
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Koera kaelarihma seadme tehnilised andmed
Aku tüüp Korduvlaetav vahetatav liitium-ioonaku, 361-00029-04

Töötemperatuuri vahemik -20 kuni 60 °C (-4 kuni 140 °F)

Laadimise temperatuurivahemik 0 kuni 40 °C (32 kuni 104 °F)

Juhtmeta sagedusalad/protokollid 152-169 MHz @ 24,2 dBm max, 2,4 GHz @ 6,9 dBm max

EU SAR 0,06 W/kg torso (simultaanne), 0,07 W/kg jäse (simultaanne),

Väikse koera kaelarihmaseadme tehnilised andmed
Aku tüüp Korduvlaetav vahetatav liitium-ioonaku, 361-00035-09

Töötemperatuuri vahemik -20 kuni 60 °C (-4 kuni 140 °F)

Laadimise temperatuurivahemik 5 kuni 40 °C (41 kuni 104 °F)

Juhtmevabad sagedusalad/protokollid 155 MHz @ 32,77 dBm max, 2,4 GHz @ -1,7 dBm max
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TT™ 15X/TT 15 mini šuns antkaklio įtaisas
Sparčiosios paleisties vadovas

Pradžia
 ĮSPĖJIMAS

Žr. vadovą Svarbi saugos ir produkto informacija, pateiktą produkto dėžėje, kad susipažintumėte su įspėjimais 
dėl produkto ir kita svarbia informacija.

Šuns antkaklio įrenginys
PASTABA: šuns antkaklio įtaisas gali atrodyti kitaip, nei pavaizduota paveikslėlyje.

VHF antena

GPS antena

Maitinimo mygtukas

Sąlyčio taškai

Būsenos šviesos diodai ir mirksintys LED švyturėliai
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Įrenginio įjungimas
• Ant šuns antkaklio įtaiso palaikykite maitinimo mygtuką, kol būsenos LED pradės mirksėti, o antkaklis 

supypsės.

Šuns antkaklio įrenginio išjungimas
Palaikykite įjungimo mygtuką, kol būsenos LED lemputė pasidarys ištisinė raudona, o prietaisas supypsės.

Šuns antkaklio įtaiso įkrovimas
PRANEŠIMAS

Kad apsaugotumėte nuo korozijos, prieš prijungdami įkroviklio apkabą kruopščiai nusausinkite antkaklio 
kontaktus ir sritį aplink juos.

PASTABA: šuns antkaklio įtaisas gali atrodyti kitaip, nei pavaizduota paveikslėlyje.
Visiškai įkraukite bateriją prieš naudodami įtaisą pirmą kartą. Visiškai išsikrovusios baterijos įkrovimas trunka 
apie penkias valandas.
1 Pritvirtinkite įkroviklio apkabą  ant įtaiso .

2 Mažesnįjį maitinimo kabelio galą įkiškite į USB miniprievadą ant įkroviklio apkabos kabelio.
3 Maitinimo kabelį įkiškite į maitinimo lizdą.

Kai atliekamas antkaklio įkrovimas, būsenos LED lemputė nuolat dega raudonai.
4 Būsenos LED lemputei užsidegus žaliai, įkroviklio apkabą nuimkite nuo antkaklio.

Palydovo signalų gavimas
Prieš uždedant šuniui antkaklį, tiek antkaklis, tiek delninis įrenginys turi gauti palydovo signalus. Gali praeiti 
kelios minutės, kol gausite signalą iš palydovo.
1 Išeikite į atvirą vietą lauke.
2 Įjunkite abu įrenginius.

 būsenos juostoje rodo GPS signalo stiprumą.
Antkakliui gavus palydovo signalus, būsenos LED sumirksi du arba tris kartus žalia šviesa.
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Šuns pridėjimas prie Alpha delninio įrenginio belaidžio susiejimo būdu
1 Jei šuns antkaklio įrenginys įjungtas, išjunkite šuns antkaklio įrenginį.
2 Laikykite paspaudę šuns antkaklio įrenginio maitinimo mygtuką, kol įrenginyje pasigirs dvi garsinio signalo 

serijos (trunka apie 2 sekundes); tada maitinimo mygtuką atleiskite.
Būsenos LED greitai mirksi žalia šviesa. Šuns antkaklio įrenginys dabar paruoštas susiejimui su delniniu 
įrenginiu.

3 Delniniame įrenginyje pasirinkite Dog List > Add Dog.
4 Pasirinkite parinktį:

• Jei esate netoli šuns antkaklio įrenginio, pasirinkite Pair Collar ir vadovaukitės ekrane pateikiamomis 
instrukcijomis.

• Jei norite susieti šuns antkaklio įrenginį gaudami informaciją iš kito delninio įrenginio, pasirinkite Receive 
from Handheld.
PASTABA: jei norite sėkmingai susieti įrenginį, kitas delninis įrenginys turi bendrinti šuns antkaklio 
įrenginio informaciją belaidžiu ryšiu.

5 Sėkmingai pridėję šuns antkaklio įrenginį, įveskite šuns vardą ir pasirinkite .

Sąlyčio taškų pasirinkimas ir tvirtinimas
 PERSPĖJIMAS

Kad nebūtų dirginami sąlyčio taškai, kas 24 valandas nuimkite antkaklį bent aštuonioms valandoms.
Nepurkškite ant įrenginio arba antkaklio stiprių chemikalų, įskaitant purškalus nuo blusų arba erkių. Prieš 
uždėdami šuniui antkaklį įsitikinkite, kad purškalas nuo blusų arba erkių visiškai išdžiuvo. Maži stiprių chemikalų 
kiekiai gali pakenkti plastikiniams komponentams ir antkaklio laminatui.

Jei norite pasiekti geriausių rezultatų, pasirinkite tinkamus sąlyčio taškus, atsižvelgdami į šuns kailį.
1 Pasirinkite jūsų šuns kailiui tinkamą sąlyčio taško ilgį:

• Šunims, kurių kailis storesnis, rinkitės ilgesnius sąlyčio taškus.
• Šunims, kurių kailis trumpesnis, rinkitės trumpesnius sąlyčio taškus.

2 Jei reikia, sąlyčio taškus pašalinkite pridedamu varžtelių raktu.
3 Prisukite sąlyčio taškus prie antkaklio.
4 Priveržkite juos pridedamu varžtelių raktu, tačiau ne per stipriai.
Uždėdami šuniui antkaklį, įsitikinkite, kad sąlyčio taškai glaudžiai liečiasi su kaklu.
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Antkaklio uždėjimas šuniui
 PERSPĖJIMAS

Kad nebūtų dirginami sąlyčio taškai, kas 24 valandas nuimkite antkaklį bent aštuonioms valandoms.
Šis įrenginys nėra skirtas naudoti su žmonėmis. Nebandykite uždėti jo kitam asmeniui.
Nepurkškite ant įrenginio arba antkaklio stiprių chemikalų, įskaitant purškalus nuo blusų arba erkių. Prieš 
uždėdami šuniui antkaklį įsitikinkite, kad purškalas nuo blusų arba erkių visiškai išdžiuvo. Maži stiprių chemikalų 
kiekiai gali pakenkti plastikiniams komponentams ir antkaklio laminatui.

Norint efektyviai dresuoti šunį, antkaklis ir įtaisas turi tinkamai priglusti. Jei antkaklis yra per laisvas arba 
neteisingai uždėtas, stimuliavimas gali būti nenuoseklus. Todėl dresavimas gali užsitęsti arba nebūti 
sėkmingas.
1 Įtaisą dėkite šuns kaklo priekyje, kad būsenos LED lemputė būtų nukreipta į šuns smakrą, o sąlyčio taškai - 

prie gerklės.
2 Priveržkite dirželį, kad jis būtų gerai prigludęs prie šuns kaklo, ir užsekite sagtį.

PASTABA: antkaklis turi tvirtai priglusti ir neturi suktis ar slysti šuns kaklu. Šuo turi galėti normaliai nuryti 
maistą ir vandenį. Turėtumėte stebėti šuns elgesį, kad įsitikintumėte, jog antkaklis neveržia.

3 Pakraipykite įtaisą, kad sąlyčio taškai įsiskverbtų į šuns kailį.
PASTABA: kad sąlyčio taškai būtų veiksmingi, jie turi liestis su šuns oda.

4 Jei dirželis per ilgas, jį nukirpkite palikdami atsargai bent 8 cm (3 colius).
PATARIMAS: galite pažymėti sagčiai užsegti naudojamą skylutę, kad ją būtų galima naudoti ir vėliau.

Šunų stebėjimas ir dresavimas
Vienas delninis įrenginys gali sekti kelis šuns antkaklio įrenginius ir kitus delninius įrenginius.

Šunų stebėjimas
Naudodamiesi stebėjimo kompasu arba žemėlapiu, delniniame įrenginyje galite stebėti savo šunį arba keletą 
šunų. Žemėlapyje rodoma jūsų ir jūsų šuns vieta bei trasos. Kompaso žymeklis nurodo dabartinės šuns buvimo 
vietos kryptį.
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Šuns dresavimas
PRANEŠIMAS

Pasidomėkite dresavimo būdais ir sužinokite, kurie iš jų labiausiai tiktų šuniui ir atitiktų jūsų poreikius. Šiame 
vadove pateikiamos kelios pagrindinės dresavimo rekomendacijos, tačiau kiekvienam šuniui reikia unikalaus 
dresavimo.
Tinkamai naudojama Alpha dresavimo sistema yra labai efektyvi dresavimo priemonė, padedanti šuniui 
išnaudoti visas galimybes. Dresavimo sistemos naudojimas turėtų būti visos dresavimo programos dalis.

Pradėkite dresuoti šunį naudodami pavadėlį, be Alpha dresavimo sistemos. Turėtumėte išmokyti šunį eiti greta, 
tupėti ir ateiti pas jus. Kai šuo supranta šias tris pagrindines komandas, galite pradėti dresuoti naudodamiesi 
šuns antkaklio įtaisu ir pavadėliu. Galiausiai, šuniui nuolat vykdant komandas naudojant pavadėlį ir antkaklį, 
galite nuimti pavadėlį ir dresuoti naudodami tik šuns antkaklio įtaisą.

Ryšys su antkakliu
Matomumo linijos tarp delninio įrenginio ir šuns antkaklio įtaiso niekas neturi užstoti, kad gautumėte geriausią 
ryšio signalą. Kad matomumo linijos sąlygos būtų geriausios, turėtumėte užlipti į aukščiausią jūsų vietovėje 
aukščio tašką (pavyzdžiui, kalvos viršūnę).

Geriausias

Geras

Prastas

Miego režimo įjungimas
PASTABA: ši funkcija veikia ne visuose šuns antkaklio įrenginio modeliuose.
Prieš įjungdami miego režimą turite stebėti savo šuns vietą naudodami suderinamą šuns antkaklio įtaisą.
Prijungus prie delninio įrenginio, šuns antkaklio įtaisą galima perjungti į miego režimą, kad būtų taupoma 
baterija, kai aktyviai nestebite savo šuns.
1 Pasirinkite Dog List.
2 Pasirinkite šunį.
3 Pasirinkite  > Adjust Collar Sleep Mode > Sleep.
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Miego režimo išjungimas
PASTABA: ši funkcija veikia ne visuose šuns antkaklio įrenginio modeliuose.
Kol aktyviai nestebite savo šuns, miego režimą suderinamame šuns antkaklio įtaise galite išjungti.
1 Pasirinkite Dog List.
2 Pasirinkite šunį.
3 Pasirinkite  > Adjust Collar Sleep Mode > Wake.

Įrenginio informacija

Kaip gauti naudotojo vadovą
Naujausią naudotojo vadovą galite gauti interneto svetainėje.
1 Eikite į www.garmin.com/support.
2 Pasirinkite Vadovai.
3 Vadovaudamiesi ekrane rodomomis instrukcijomis pasirinkite savo įrenginį.

Šuns antkaklio įrenginio programinės įrangos atnaujinimas
Prieš atnaujindami šuns antkaklio įrenginio programinę įrangą, turite prijungti šuns antkaklio įrenginį prie 
kompiuterio.
PASTABA: galite prijungti tik prie kompiuterio. Atnaujinant programinę įrangą jokie jūsų duomenys ar 
nustatymai nebus ištrinti.
1 Eikite į www.garmin.com/products/webupdater.
2 Vadovaukitės ekrane pateikiamomis instrukcijomis.

Informacija apie VHF radiją
Šį gaminį galima naudoti tik konkrečiose radijo dažnių juostose, kurios skiriasi priklausomai nuo naudojimo 
šalies. Delniniame įrenginyje ir šuns įrenginyje galima montuoti kitą anteną. Pakeitus anteną, gali pagerėti radijo 
veikimas ir padidėti spinduliuojamoji galia. Draudžiama naudoti įrenginį su kitų gamintojų antenomis arba 
Garmin nepatvirtintomis antenomis. Adresu www.garmin.com/tracking-legal pateikta daugiau informacijos apie 
šio produkto veikimą ir radijo dažnį, leidžiamus priedus ir galios apribojimus įvairiose šalyse.
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Antenos ir antenos laikiklio tvirtinimas prie antkaklio
PRANEŠIMAS

Naudodami kabelių dirželius, įsitikinkite, kad jokie aštrūs kraštai nesiliečia su jūsų šuns oda.

Galite pritvirtinti anteną ir antenos laikiklį prie antkaklio, norėdami optimaliai priderinti savo šuns antkaklio 
įrenginį.
Kad radijas veiktų kaip galima geriau, antena turi būti nukreipta tiesiai, kai ji uždėta ant jūsų šuns. Priklausomai 
nuo jūsų šuns kaklo dydžio, jums gali reikėti naudoti kabelių dirželius, kad tinkamai uždėtumėte anteną.
1 Pritvirtinkite antenos laikiklį  prie antkaklio vienu iš pristatomų kabelių dirželių .

2 Pritvirtinkite anteną  prie antkaklio vienu iš pristatomų kabelių dirželių .
3 Nupjaukite per ilgus kabelių dirželių galus.

Šuns antkaklio įrenginio specifikacijos
Baterijos tipas Įkraunamoji, keičiamoji, ličio jonų, 361-00029-04

Darbinės temperatūros diapazonas Nuo –20 iki 60 °C (nuo –4 iki 140 °F)

Įkrovimo temperatūros diapazonas Nuo 0 iki 40 °C (nuo 32 iki 104 °F)

Belaidžio ryšio dažniai / protokolai 152–169 MHz esant 24,2 dBm, maksimali vertė, 2,4 GHz esant 6,9 dBm, 
maksimali vertė

ES Savitosios sugerties sparta (SAR) 0,06 W/kg vienalaikė liemeniui, 0,07 W/kg vienalaikė galūnei

Šuns antkaklio mini įrenginio specifikacijos
Baterijos tipas Įkraunamoji, keičiamoji, ličio jonų, 361-00035-09

Darbinės temperatūros diapazonas Nuo –20 iki 60 °C (nuo –4 iki 140 °F)

Įkrovimo temperatūros diapazonas Nuo 5 iki 40 °C (nuo 41 iki 104 °F)

Belaidžio ryšio dažniai / protokolai 155 MHz esant 32,77 dBm, maksimali vertė, 2,4 GHz esant –1,7 dBm, 
maksimali vertė
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TT™ 15X/TT 15 mini suņu kaklasiksnas ierīce
Īsa uzsākšanas rokasgrāmata

Darba sākšana
 BRĪDINĀJUMS

Skatiet ierīces komplektācijā iekļauto ceļvedi Svarīga informācija par drošību un ierīci, lai uzzinātu uz ierīci 
attiecināmos brīdinājumus un citu svarīgu informāciju.

Suņa kaklasiksnas ierīce
PIEZĪME. jūsu suņu kaklasiksnas ierīce var izskatīties citādi nekā attēlā redzamā.

VHF antena

GPS antena

Barošanas poga

Kontaktvietas

Statusa gaismas diode un mirgojošas gaismas signālu diodes
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Ierīces ieslēgšana
• Suņa kaklasiksnas ierīcē turiet nospiestu barošanas pogu, līdz statusa gaismas diode mirgo un kaklasiksnas 

ierīce raida skaņas signālu.

Suņa kaklasiksnas ierīces izslēgšana
Turiet nospiestu barošanas taustiņu, līdz statusa gaismas diode iedegas sarkanā krāsā un ierīce atskaņo 
skaņas signālu.

Suņu kaklasiksnas ierīces uzlāde
IEVĒRĪBAI

Pirms uzlādes spailes pievienošanas rūpīgi nosusiniet kontaktus un aptverošo zonu, lai novērstu koroziju.

PIEZĪME. jūsu suņu kaklasiksnas ierīce var izskatīties citādi nekā attēlā redzamā.
Pirms lietojat ierīci pirmo reizi, akumulators ir pilnīgi jāuzlādē. Pilnīgi tukša akumulatora uzlādei ir 
nepieciešamas aptuveni piecas stundas.
1 Uzlieciet uzlādes spaili  uz ierīces .

2 Barošanas kabeļa mazo galu iespraudiet uzlādes spailes kabeļa mini-USB portā.
3 Iespraudiet barošanas kabeli barošanas avotā.

Kad kaklasiksna lādējas, statusa gaismas diode deg sarkanā krāsā.
4 Kad statusa gaismas diode iedegas zaļā krāsā, noņemiet uzlādes spaili no kaklasiksnas.

Satelīta signālu iegūšana
Pirms kaklasiksnas uzlikšanas uz suņa, gan apkaklei, gan portatīvajai ierīcei jāiegūst satelīta signāli. Satelītu 
atrašana var ilgt dažas minūtes.
1 Dodieties ārā atklātā teritorijā.
2 Ieslēdziet abas ierīces.

 statusa joslā rāda GPS signāla stiprumu.
Kad kaklasiksna ir ieguvusi satelīta signālus, statusa gaismas diode iemirgojas divreiz vai trīsreiz zaļā krāsā.
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Suņa pievienošana Alpha portatīvajai ierīcei, izmantojot bezvadu pāra savienojumu
1 Ja suņa apkakles ierīce ir ieslēgta, izslēdziet to.
2 Turiet nospiestu suņa apkakles barošanas taustiņu līdz ierīce atskaņo divu skaņas signālu sēriju (aptuveni 2 

sekundes), un tad atlaidiet barošanas taustiņu.
Statusa gaismas diode ātri mirgo zaļā krāsā. Suņa apkakles ierīce tagad ir gatava savienošanai vai pāra 
savienojuma izveidei ar portatīvo ierīci.

3 Portatīvajā ierīcē atlasiet Dog List > Add Dog.
4 Atlasiet opciju:

• Ja atrodaties suņa apkakles ierīces tuvumā, atlasiet Pair Collar, un izpildiet ekrānā redzamās instrukcijas.
• Lai suņa apkakles ierīcei izveidotu pāra savienojumu, saņemot informāciju no citas portatīvās ierīces, 

atlasiet Receive from Handheld.
PIEZĪME. lai sekmīgi izveidotu pāra savienojumu, otrai portatīvajai ierīcei ir jākoplieto suņa apkakles 
ierīces informācija bezvadu režīmā.

5 Pēc sekmīgas suņa apkakles ierīces pievienošanas, ievadiet suņa vārdu un atlasiet .

Kontaktvietu izvēle un instalēšana
 UZMANĪBU

Lai novērstu kairinājumu kontaktvietās, reizi diennaktī noņemiet kaklasiksnu vismaz uz astoņām stundām.
Nesmidziniet uz ierīces vai kaklasiksnas spēcīgas ķīmiskas vielas, tostarp (bet ne tikai) līdzekļus pret blusām 
vai ērcēm. Pirms uzliekat kaklasiksnu sunim, vienmēr pārliecinieties, ka tam lietotie smidzināmie līdzekļi pret 
blusām vai ērcēm ir pilnībā nožuvuši. Neliels daudzums spēcīgu ķīmisku vielu var bojāt plastmasas sastāvdaļas 
un kaklasiksnas laminātu.

Lai iegūtu vislabākos rezultātus, izvēlieties pareizās kontaktvietas, ņemot vērā sava suņa kažoku.
1 Izvēlieties pareizu kontaktvietas garumu, kas atbilst jūsu suņa kažokam:

• Suņiem ar biezu kažoku, izmantojiet garākas kontaktvietas.
• Suņiem ar īsu kažoku, izmantojiet īsākas kontaktvietas.

2 Ja nepieciešams, izmantojiet komplektā iekļauto uzgriežņu atslēgu, lai noņemtu kontaktvietas.
3 Iespiediet kontaktvietas kaklasiknā.
4 Pievelciet ar komplektā iekļauto uzgriežņu atslēgu, bet nepārvelciet.
Uzliekot kaklasiksnu uz suņa, pārliecinieties, vai kontaktvietas cieši piekļaujas kaklam.
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Kaklasiksnas uzlikšana sunim
 UZMANĪBU

Lai novērstu kairinājumu kontaktvietās, reizi diennaktī noņemiet kaklasiksnu vismaz uz astoņām stundām.
Šī ierīce nav paredzēta lietošanai cilvēkiem. Nemēģiniet to lietot uz kādas personas.
Nesmidziniet uz ierīces vai kaklasiksnas spēcīgas ķīmiskas vielas, tostarp (bet ne tikai) līdzekļus pret blusām 
vai ērcēm. Pirms uzliekat kaklasiksnu sunim, vienmēr pārliecinieties, ka tam lietotie smidzināmie līdzekļi pret 
blusām vai ērcēm ir pilnībā nožuvuši. Neliels daudzums spēcīgu ķīmisku vielu var bojāt plastmasas sastāvdaļas 
un kaklasiksnas laminātu.

Lai efektīvi apmācītu suni, kaklasiksna un ierīce ir pareizi jāuzliek sunim. Ja kaklasiksna ir pārāk vaļīga vai 
uzlikta nepareizi, stimulācija var būt neatbilstīga. Tas var aizkavēt vai novērst sekmīgu apmācību.
1 Novietojiet ierīci suņa kakla priekšā, gaismas diodi vēršot pret suņa zodu un kontaktvietas — pret rīkli.
2 Pievelciet siksnu, lai tā labi piegulst suņa kaklam, un aizsprādzējiet.

PIEZĪME. kaklasiksnai ir cieši jāpiegulst, un tā nedrīkst griezties vai slīdēt uz suņa kakla. Sunim ir jāspēj 
normāli norīt ēdienu un ūdeni. Jums ir jānovēro suņa uzvedība, lai pārliecinātos, ka kaklasiksna nav pārāk 
stingri savilkta.

3 Pagroziet ierīci, lai kontaktvietas iedarbojas caur suņa kažoku.
PIEZĪME. lai ierīce efektīvi darbotos, kontaktvietām ir jābūt saskarē ar suņa ādu.

4 Ja siksna ir pārāk gara, nogrieziet lieko daļu, atstājot vismaz 8 cm (3 collu) gabalu.
IETEIKUMS. turpmākai atsaucei varat atzīmēt caurumu, ko izmantojat aizsprādzēšanai.

Suņu izsekošana un apmācība
Viena portatīvā ierīce var izsekot vairākām suņu kaklasiksnas ierīcēm un citām portatīvajām ierīcēm.

Suņa izsekošana
Portatīvā ierīce ļauj sekot līdzi jūsu sunim vai vairākiem suņiem, izmantojot izsekošanas kompasu vai karti. 
Kartē tiek attēlota jūsu atrašanās vieta, kā arī suņa atrašanās vieta un maršruti. Kompasa rādītājs norāda suņa 
pašreizējās atrašanās vietas virzienu.
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Suņa apmācība
IEVĒRĪBAI

Izanalizējiet un izpētiet jums un jūsu sunim piemērotākās apmācību metodes. Šajā rokasgrāmatā ir sniegtas 
dažas pamatnostādnes apmācībai, bet katram sunim ir unikālas apmācību vajadzības.
Ja izmantota pareizi, Alpha apmācību sistēma ir ļoti efektīvs apmācību rīks, lai palīdzētu sunim sasniegt pilnīgu 
tā potenciālu. Apmācību sistēmas izmantošanai vajadzētu būt daļai no vispārējās apmācību programmas.

Sāciet apmācību, turot suni saitē un neizmantojot Alpha apmācību sistēmu. Jums ir jāmāca sunim, kā iet 
blakus, sēdēt un nākt pie jums. Kad suns saprot šīs trīs pamata komandas, varat sākt apmācību ar suņu 
kaklasiksnas ierīci, turot suni saitē. Visbeidzot, kad suns pastāvīgi klausa komandām, izmantojot saiti un 
kaklasiksnu, varat noņemt saiti, lai apmācītu, izmantojot tikai suņu kaklasiksnas ierīci.

Sakari ar kaklasiksnu
Lai iegūtu vislabākos sakaru signālus, skata līnijai starp portatīvo ierīci un suņu kaklasiksnu ir jābūt bez 
šķēršļiem. Lai iegūtu vislabākos skata līnijas apstākļus, jums ir jādodas uz augstāko vietu savā teritorijā 
(piemēram, uzkalna virsotni).

Vislabākais

Labi

Vāji

Miega režīma aktivizēšana
PIEZĪME. šī funkcija nav pieejama visiem suņu kaklasiksnas ierīču modeļiem.
Lai pārietu miega režīmā, jums ir jāizseko suņa atrašanās vieta, izmantojot saderīgu suņu kaklasiksnas ierīci.
Kad izveidots savienojums ar portatīvo ierīci, suņu kaklasiksnas ierīci var pārslēgt miega režīmā, lai taupītu 
enerģiju, kad aktīvi neizsekojat savu suni.
1 Atlasiet Dog List.
2 Atlasiet suni.
3 Atlasiet  > Adjust Collar Sleep Mode > Sleep.

Iziešana no miega režīma
PIEZĪME. šī funkcija nav pieejama visos suņu kaklasiknu ierīču modeļos.
Kamēr aktīvi neizsekojat savu suni, varat iziet no saderīgās suņu kaklasiksnas miega režīma.
1 Atlasiet Dog List.
2 Atlasiet suni.
3 Atlasiet  > Adjust Collar Sleep Mode > Wake.

70 Īsa uzsākšanas rokasgrāmata



Informācija par ierīci

Īpašnieka rokasgrāmatas iegūšana
Tīmekļa vietnē varat iegūt jaunāko īpašnieka rokasgrāmatu.
1 Dodieties uz vietni www.garmin.com/support.
2 Atlasiet Rokasgrāmatas.
3 Izpildiet ekrānā redzamās norādes, lai atlasītu savu produktu.

Suņa kaklasiksnas ierīces programmatūras atjaunināšana
Lai atjauninātu suņa kaklasiksnas ierīces programmatūru, kaklasiksnas ierīce jāpievieno pie datora.
PIEZĪME. tikai izmantojot datoru. Programmatūras atjaunināšana nedzēš nekādus jūsu datus vai iestatījumus.
1 Dodieties uz vietni www.garmin.com/products/webupdater.
2 Izpildiet ekrānā redzamos norādījumus.

VHF radio informācija
Šo izstrādājumu drīkst lietot tikai noteiktās radiofrekvencēs, un tās atšķiras atkarībā no valsts, kurā 
izstrādājums tiek lietots. Portatīvā ierīce un suņa ierīce ļauj lietotājam uzstādīt dažādas antenas. Antenas 
nomaiņa var uzlabot radio darbību un nodrošināt lielāku jaudu. Jūs nedrīkstat lietot ierīci ar trešās puses antenu 
vai antenu, ko nav apstiprinājis uzņēmums Garmin. Dodieties uz www.garmin.com/tracking-legal un skatiet 
sīkāku informāciju par šā produkta veiktspēju un radiofrekvenci, dažādās valstīs atļautajiem piederumiem un 
jaudas ierobežojumiem.

Antenas un antenas turētāja pievienošana kaklasiksnai
IEVĒRĪBAI

Izmantojot kabeļu saites, pārliecinieties, ka asās malas nesaskaras ar jūsu suņa ādu.

Varat pievienot antenu un antenas turētāju pie kaklasiksnas, lai uzlabotu suņa kaklasiksnas ierīces 
piekļaušanos pie suņa.
Lai nodrošinātu maksimālu radio veiktspēju, antenai ir jābūt vērstai tieši uz augšu, kad tā atrodas uz suņa. 
Atkarībā no suņa kakla izmēra, var būt nepieciešams izmantot kabeļa saites, lai pareizi novietotu antenu.
1 Pievienojiet antenas turētāju  pie kaklasiksnas, izmantojot vienu no kabeļa saitēm .

2 Pievienojiet antenu  pie kaklasiksnas, izmantojot vienu no kabeļa saitēm .
3 Nogrieziet lieko kabeļu saites galu.
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Suņa kaklasiksnas ierīces specifikācijas
Akumulatora veids Atkārtoti lādējama, maināma litija jonu, 361-00029-04

Darba temperatūras diapazons No -20° līdz 60°C (no -4° līdz 140°F)

Uzlādes temperatūras diapazons No 0° līdz 40°C (no 32° līdz 104°F)

Bezvadu frekvences/protokoli 152–169 MHz ar 24,2 dBm maksimumu, 2,4 GHz ar 6,9 dBm maksimumu

EU SAR 0,06 W/kg vienlaicīgi rumpis, 0,07 W/kg vienlaicīgi ķermeņa locekļi

Mini suņu kaklasiksnas ierīces specifikācijas
Bateriju veids Atkārtoti lādējama, maināma litija jonu, 361-00035-09

Darba temperatūras diapazons No -20° līdz 60°C (no -4° līdz 140°F)

Uzlādes temperatūras diapazons No 5° līdz 40°C (no 41° līdz 104°F)

Bezvadu frekvences/protokoli 155 MHz ar 32,77 dBm maksimumu vai 2,4 GHz ar -1,7 dBm maksimumu
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Getting Started
 WARNING

See the Important Safety and Product Information guide in the product box for product warnings and other 
important information.

Setting Up the Alpha System
Before you can use the Alpha system, you must set up the devices.
1 Charge the handheld device (Charging the Handheld Device, page 5).
2 Charge the dog collar device (Charging the Dog Collar Device, page 6).
3 Turn on the devices (Turning On the Device, page 6).
4 Select a language (Selecting a Language, page 6).
5 If necessary, pair the dog collar device with the handheld device (Methods to Add a Dog Collar Device to a 

Handheld Device, page 7).
6 If necessary, calibrate the compass on the handheld device (Calibrating the Compass, page 24).
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Device Overviews

Alpha Handheld Device
NOTICE

Avoid using a high-powered radio (greater than 5 W) in close proximity to the handheld device. It may cause 
irreversible damage to the handheld device.

Satellite antenna

VHF radio antenna

Mounting spine

microSD® memory card slot (under battery)

Battery cover D-ring

Micro-USB port (under weather cap)
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Alpha Device Keys

Power key

Customizable training keys

Training up

Training down

Training enter
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Dog Collar Device
NOTE: Your dog collar device may look different than the device pictured.

VHF antenna

GPS antenna

Power key

Status LED and flashing beacon LEDs

Installing the Battery Pack
1 Turn the D-ring counter-clockwise, and pull up to remove the cover.
2 Locate the metal contacts on the end of the lithium-ion battery.
3 Insert the battery into the compartment, contacts first.

4 Press the battery into place.
5 Replace the battery cover, and turn the D-ring clockwise.
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Charging the Handheld Device
NOTICE

To prevent corrosion, thoroughly dry the USB port, the weather cap, and the surrounding area before charging or 
connecting to a computer.

NOTE: The device does not charge when it is outside the approved temperature range (Alpha Handheld Device 
Specifications, page 31).
You should fully charge the battery before you use the device for the first time. Charging a fully depleted battery 
takes about 4 hours.
1 Lift the weather cap .

2 Plug the small end of the power cable into the USB port  on the device.
3 Plug the other end of the power cable into an appropriate power source.
The LCD display on the handheld device shows the current battery charge level.

Getting Started 5



Charging the Dog Collar Device
NOTICE

To prevent corrosion, thoroughly dry the contacts on the collar and the surrounding area before connecting the 
charging clip.

NOTE: Your dog collar device may look different than the device pictured.
You should fully charge the battery before you use the device for the first time. Charging a fully depleted battery 
takes about five hours.
1 Snap the charging clip  onto the device .

2 Plug the small end of the power cable into the mini-USB port on the charging clip cable.
3 Plug the power cable into a power source.

The status LED is solid red when the collar is charging.
4 After the status LED turns solid green, remove the charging clip from the collar.

Turning On the Device
• On the handheld device, press the power key.
• On the dog collar device, hold the power key until the status LED flashes and the collar beeps.

Turning Off the Device
• On the handheld device, hold the power key until the LCD screen turns off.
• On the dog collar device, hold the power key until the status LED turns red.

Selecting a Language
When you turn on your device for the first time, you will select the device language from a list of available 
languages. You can change the language setting from the System settings.
1 From the main menu, select Setup > System > Language.
2 Select a language.

Using the Touchscreen
• Select  to open a menu.
• Select  to return to the home screen.
• Select  to return to the previous page.
• If you are more than one menu away from the home screen, select and hold  to return to the home 

screen.
• If scroll controls are enabled, select  and  to scroll (Accessibility Settings, page 28).
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Using the Status Page
The status page displays the time, your GPS signal strength, and the device battery life. It also allows you to 
adjust settings and access shortcuts. You can open the status page from any other page by pressing the power 
key.
Screen brightness: Adjusts the brightness of the screen.
Lock Screen: Locks the touchscreen to prevent inadvertent screen touches.
Lock Keys: Locks the device keys to prevent inadvertent key presses.
My ID: Displays your device ID and allows you to transmit your device information to a compatible handheld 

device. You can also turn the transmitter on and off.
Alerts: Displays unread dog alerts.

Acquiring Satellite Signals
Both the collar and handheld device must acquire satellite signals before you put the collar on your dog. 
Acquiring satellites can take a few minutes.
1 Go outdoors to an open area.
2 Turn on both devices (Turning On the Device, page 6).

 in the status bar shows the GPS signal strength.
When the collar has acquired satellite signals, the status LED flashes a double-blink or triple-blink in green.

Dog Collar Device Setup
Methods to Add a Dog Collar Device to a Handheld Device
You can add up to 100 devices to one handheld device by using MURS/VHF, entering the track and control 
codes, or by sharing wirelessly using ANT+® technology. Up to 20 devices can be active at one time.
Using MURS/VHF: Allows you to add a dog collar device after you have placed the dog collar device into pairing 

mode by pressing the power key.
This method is helpful when you are adding a new accessory collar to the system prior to leaving for the 
hunt (Adding a Dog to the Alpha Handheld Using Wireless Pairing, page 8).

Entering the track and control codes: Allows you to add a dog collar device that you do not own and that is not 
in the area. The dog's owner must determine if you can only track the dog or can track and control the dog. 
This method requires the dog's owner to find and communicate the codes to the person adding the dog 
collar device.
This method is helpful when you would like to add a dog collar device during a hunt, but you are not near the 
dog. For example, you are adding another member of your hunting party's dog collar device to your handheld 
device, but you do not own the dog collar device (Adding a Dog Using the Track and Control Codes, 
page 8).
NOTE: This feature varies based on dog collar device type and feature availability in your area. You may see 
track codes only or track and control codes.

Sharing wirelessly using ANT+ wireless technology: Allows you to add a dog collar device that you do not own 
and that is not in the area. The dog's owner must determine if you can only track the dog or can track and 
train the dog. This method does not require the dog's owner to find and communicate the codes to the 
person adding the dog collar device. This method also adds dog information, such as the dog's name, 
communication settings, and initial position, from the sending handheld device to your device. The two 
handheld devices must be within range 3 m (10 ft.) to share data wirelessly.
This method is helpful when you want to add a dog collar device during a hunt, but you are not near the dog. 
For example, the dogs have already been let loose, and you are near the dog owner, who can share the dog 
wirelessly (Sharing a Dog Wirelessly, page 8).
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Adding a Dog to the Alpha Handheld Using Wireless Pairing
1 If the dog collar device is on, turn off the dog collar device (Turning Off the Device, page 6).
2 Hold the power key on the dog collar device until the device emits two series of beeps (about 2 seconds), 

and then release the power button.
The status LED flashes rapidly in green. The dog collar device is now ready to be linked, or paired, with a 
handheld device.

3 On the handheld device, select Dog List > Add Dog.
4 Select an option:

• If you are near the dog collar device, select Pair Collar, and follow the on-screen instructions.
• To pair a dog collar device by receiving the information from another handheld device, select Receive 

from Handheld.
NOTE: To successfully pair the device, the other handheld device must be wirelessly sharing the dog 
collar device information (Sharing a Dog Wirelessly, page 8).

5 After successfully adding the dog collar device, enter the name of the dog, and select .

Sharing a Dog Wirelessly
Before you can share data wirelessly over ANT+, you must bring your Alpha handheld device within 3 m (10 ft.) 
of the other handheld device.
1 Select Dog List.
2 Select the dog to share.
3 Select  > Share Wirelessly.
4 Select an option:

• To allow the other person to track your dog's location with the map and dog tracking compass, select 
Track Only.

• To allow the other person to track your dog and correct your dog's behavior, select Track and Train.
To successfully share the dog collar device, the other handheld device must be receiving the device 
information (Adding a Dog to the Alpha Handheld Using Wireless Pairing, page 8).

Adding a Dog Using the Track and Control Codes
NOTE: This feature varies based on dog collar device type and feature availability in your area.
Before you can add a dog using the track and control codes, the dog owner must find the track and control 
codes (Finding the Dog ID and Track and Control Codes, page 8) and tell them to you.
You can use track and control codes to authorize a handheld device to interact with your dog collar device. If 
you are not near the dog you want to add or you cannot put the collar into pairing mode, you can add the dog 
using the track and control codes.
1 Select Dog List > Add Dog.
2 Select Enter Track or Control Code.
3 Enter the track or control code for the collar, and select .

The dog’s track code allows you to track the dog. The dog’s control code allows you to both track and train 
the dog.

4 Enter the name of the dog, and select .

Finding the Dog ID and Track and Control Codes
You can share a dog’s track code so another person can track your dog. Also, you can share a dog’s control 
code so another person can track and train your dog.
1 Select Dog List.
2 Select a dog.

The track code and the control code are displayed under the dog's name.
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VHF Radio Information
This product may be used only on specific radio frequencies, which vary depending on the country of use. The 
handheld device and the dog device allow the user to install a different antenna. Changing the antenna can 
result in improved radio performance and higher radiated power. You must not use the device with a third party 
antenna or an antenna not approved by Garmin®. Go to www.garmin.com/tracking-legal for details about the 
performance and radio frequency of this product, lawful accessories, and power limits for countries.

Managing a Group
Before you can create a group, you must pair one or more dog devices to your handheld.
1 Select Dog List.
2 Select .
3 If necessary, select Create Group, and enter a group name.
4 Select a group from the list.
5 Select an option:

• To activate the group, select Activate Group.
• To deactivate the group, select Deactivate Group.
• To add a device to the group, select Manage Group > Add Device.
• To rename the group, select Rename, and enter a new name.
• To delete the group, select Delete Group.

Editing Dog Information

Resetting a Dog's Statistics and Track
You might want to clear the dog statistics and track before a new hunt.
1 Select Dog List.
2 Select a dog.
3 Select  > Reset.

Changing the Dog Name
1 Select Dog List.
2 Select a dog.
3 Select the dog’s name.
4 Enter the name, and select .

Changing the Color of the Dog's Track
You can change the track color of the dog. It is helpful to have the track color match the color of the collar 
strap, if possible.
1 Select Dog List.
2 Select a dog.
3 Select the colored square next to the dog’s name.
4 Select a color.

Changing the Dog Type
Before you can change the dog type, the collar must be turned on and within range of the handheld device.
1 Select Dog List.
2 Select a dog.
3 Select  > Change Dog Type.
4 Select a dog type.
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Changing the Dog ID
Before you can change the dog ID, the collar must be turned on and within range of the handheld device.
If you are experiencing interference from other collars or handheld devices in the area, you might need to 
change the ID for the dog.
1 Select Dog List.
2 Select a dog.
3 Select  > Change ID.
4 Select an available ID.
If another handheld device is tracking this dog, for best results, remove the dog from the device, and use the 
track and control codes to add the dog again (Adding a Dog Using the Track and Control Codes, page 8).

Removing a Dog
1 Select Dog List.
2 Select a dog.
3 Select  > Remove.

Fitting the Collar on Your Dog
 CAUTION

Do not spray the device or collar with harsh chemicals including but not limited to flea or tick spray. Always 
ensure that any flea or tick spray that is applied to the dog is completely dry before placing the collar on the 
dog. Small amounts of harsh chemicals can damage the plastic components and collar laminate.

Before you can put the collar on the dog, you must pair the handheld device and collar (Adding a Dog to the 
Alpha Handheld Using Wireless Pairing, page 8), and acquire satellite signals (Acquiring Satellite Signals, 
page 7).
1 Position the collar with the communication antenna pointing up, the GPS antenna facing up, and the LEDs 

facing forward.
2 Place the collar around the middle of the dog's neck.
3 Tighten the strap so it is snug around the dog's neck.

NOTE: The collar should fit tightly and should not be able to rotate or slide on the dog's neck. The dog must 
be able to swallow food and water normally. You should observe your dog's behavior to verify the collar is 
not too tight.

4 If the strap is too long, cut off the excess, leaving at least 7.62 cm (3 in.) to spare.
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Communication with the Collar
You should keep an unobstructed line of sight between your handheld device and the dog collar device to 
produce the best communication signal. To achieve the best line-of-sight conditions, you should move to the 
highest elevation point in your area (for example, on the top of a hill).

Best

Good

Poor

Entering Sleep Mode
NOTE: This feature is not available with all dog collar device models.
Before you can enter sleep mode, you must track your dog's location using the compatible dog collar device.
When connected with the handheld device, the dog collar device can be put into sleep mode to conserve the 
battery when you are not actively tracking your dog.
1 Select Dog List.
2 Select a dog.
3 Select  > Adjust Collar Sleep Mode > Sleep.

Exiting Sleep Mode
NOTE: This feature is not available with all dog collar device models.
You can exit sleep mode on the compatible dog collar device while you are not actively tracking your dog.
1 Select Dog List.
2 Select a dog.
3 Select  > Adjust Collar Sleep Mode > Wake.

Dog Tracking
The handheld device allows you to track your dog or multiple dogs, using the tracking compass or map. The 
map displays your location and your dog's location and tracks. The compass pointer indicates the direction of 
the dog's current location.

Dog Tracking 11



Tracking Your Dog on the Map
Before you can track a dog on the map, you must add it to the handheld device (Adding a Dog to the Alpha 
Handheld Using Wireless Pairing, page 8).
You can view the dog's location on the map.
1 From the home screen, select .

2 If necessary, select  and  to zoom in and out of the map.
TIP: You can select  to track the dog using the dog tracking compass (Dog Tracking Compass, page 13).

Dog Status Icons

Sitting

Running

On point

Treed

Unknown1

1 The unknown status icon indicates that the collar has not acquired a satellite signal and that the handheld device cannot determine the location of the dog.
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Dog Tracking Compass
To open the dog tracking compass, select .

You can use the dog tracking compass to view the direction and distance to your dog, your vehicle, and any 
paired devices. The dog tracking compass also shows the dog's status, such as running or on point (Dog Status 
Icons, page 12). The color of the pointer corresponds to the color of the track.
The dog tracking compass is most accurate when the dog, vehicle, or paired device is more than 9.1 m (30 ft.) 
away. When the dog, vehicle, or paired device is less than 9.1 m (30 ft.) away, "Near" appears.
TIP: You can open an alternative view of the compass by selecting  > Pro View.

Navigating to Your Dog
1 Select Dog List.
2 Select the dog.
3 Select  > Go.
4 Follow the colored line to the dog.

Changing the Length of the Dog's Track
You can adjust the length of time the dog track appears on the map. Reducing the duration of the track can 
reduce the clutter on the map. Changing the map does not affect the tracks stored in the handheld device.
1 Select Setup > Map > Tracked Devices > Dog Tracks on Map.
2 Select a time frame.

Location Alerts
Location alerts notify you when your dogs enter or exit a particular location. You can create a custom geofence 
or use a radius around your current location.
A geofence is an invisible boundary around an area and is created using points on the map. The virtual 
boundaries of a geofence are accurate up to approximately 3 m (10 ft.). Geofences perform best when sized to 
cover an area encompassing an average sized backyard (approximately ¼ acre).
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Setting Location Alerts
1 Select Location Alerts > Add Alert.
2 Select an option:

• To create a geofence alert, select Geofence, select a point for the first corner of the geofence, select Use, 
and select additional points to define the geofence boundary.
You must select at least 3 points to create a geofence alert.

• To create a radius alert, select Radius, select the unit of measurement, and enter the radius distance.

Editing Location Alerts
1 Select Location Alerts.
2 Select an alert.
3 Select an option:

• Select Disable to turn off notifications for this alert.
• Select Set Alert Type to set the way the device notifies you for this alert.
• Select Set Alert Mode to set the notification to sound on exit, entrance, or both.
• Select View Map to view a geofence on the map.

NOTE: This feature is not available for the radius alert type.
• Select Delete to remove the alert.

Disabling Dog Data Broadcast
By default, the handheld device broadcasts dog data to compatible devices. You can disable data broadcasting 
to keep your data from being seen on other compatible devices. See the owner's manual for your compatible 
device for more information.

Select Setup > System > Broadcast Dog Data > Off.

Dog Training
NOTICE

You should research and investigate the training methods best suited for you, your dog, and your needs. This 
manual provides some basic guidelines for training, but each dog has unique training needs.
When used properly, the Alpha training system is a very effective training tool to aid your dog in reaching its full 
potential. The use of the training system should be part of an overall training program.

Begin training your dog on a leash, without the Alpha training system. You should train your dog how to heel, sit, 
and come to you. After the dog understands these three basic commands, you can begin training with the dog 
collar device and the leash. Finally, when the dog consistently obeys commands using the leash and collar, you 
may be able to remove the leash to train with only the dog collar device.

Training Methods
NOTE: Training features are not available in all areas for tracking collars.
Tone: Activates an audible tone the entire time you press the training key.
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Customizing the Training Keys
You can assign an application, device action, or utility to a training key. If a compatible dog collar is paired, you 
can also add a dog training command to a training key. You can add multiple pages of training key settings. For 
example, this is useful when training multiple dogs.
NOTE: This feature is not available with all dog collar device models.
1 Select Training Setup > Training Keys.
2 Select Add Item Here below the empty key you are customizing.
3 Select a command category.
4 Select a command or, if selecting a training command, select the name of the dog to command.
5 If selecting a dog training command, select tone (T) or light (L).
6 If you want to customize more than three keys, use the additional rows to add another page of training key 

commands.

Using the Hard Keys for Training Adjustments
Before you can use this feature, you must customize your training keys with dog training commands 
(Customizing the Training Keys, page 15).
You can access and adjust training commands using the device's hard keys.
1 From any screen, press the training up and down keys until the command page you want to adjust appears.
2 Press the training enter key to select the command page.
3 Use the training up and training down keys to highlight the training command you want to change, and press 

the training enter key.
4 Select the command mode, and press the training enter key.
5 If necessary, use the training up and down keys to adjust the command setting.
6 Press the training enter key to return to the previous screen.

Default Training Settings
From the main menu, select Training Setup > Training Defaults.
Add When Paired: Automatically sets default training modes for each button when a new dog collar is paired.
Left Button: Sets the default training mode for the left training button.
Center Button: Sets the default training mode for the center training button.
Right Button: Sets the default training mode for the right training button.

Connected Features
Connected features are available for your Alpha device when you connect the device to a wireless network or a 
compatible smartphone using Bluetooth® technology. Some features require you to install the Garmin Explore™

app on your smartphone. Go to garmin.com/apps for more information.
BirdsEye imagery: Allows you to download BirdsEye Satellite Imagery directly to your device when connected to 

a Wi‑Fi® network.
Garmin Explore: The Garmin Explore app syncs and shares waypoints, tracks, and routes with your device. You 

can also download maps to your smartphone for offline access.
Software Updates: Allows you to receive updates for your device software when connected to a Wi‑Fi network.
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Pairing a Smartphone with Your Device
1 Bring your compatible smartphone within 10 m (33 ft.) of your device.
2 From the main menu on your device, select Setup > Bluetooth.
3 On your compatible smartphone, enable Bluetooth technology, and open the Garmin Explore app.
4 From the Garmin Explore app, select Devices > Pair Device.
5 Follow the on-screen instructions in the Garmin Explore app to pair your device.

Connecting to a Wireless Network
1 Select Setup > Wi-Fi.
2 Select the toggle switch to enable Wi‑Fi technology, if necessary.
3 Select Add Network.
4 Select a wireless network from the list and enter the password, if necessary.
The device stores the network information and connects automatically when you return to this location.

Garmin Explore
The Garmin Explore website and mobile app allow you to plan trips and use cloud storage for your waypoints, 
routes, and tracks. They offer advanced planning both online and offline, allowing you to share and sync data 
with your compatible Garmin device. You can use the mobile app to download maps for offline access, and 
then navigate anywhere without using your cellular service.
You can download the Garmin Explore app from the app store on your smartphone, or you can go to 
explore.garmin.com.

Contact Tracking
You can track other hunters so you know where they are at all times. You can also send messages to your 
contacts. One Alpha handheld device can track up to 20 devices, including compatible dog collar devices and 
Alpha handheld devices.

Turning On and Off the Transmitter
Before you can add a contact or initiate an emergency alert, you must ensure the transmitter is enabled.
NOTE: In cold temperatures, if you transmit when the battery is low, the device may shut down.
1 Press  to open the status page.
2 Select My ID > Transmitting.
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Methods to Add a Contact to a Handheld Device
Using MURS/VHF: Allows you to add a handheld device contact after you have placed your handheld device 

into pairing mode.
This method is helpful when you are adding a new device to the system prior to leaving for the hunt (Adding 
a Contact Using Wireless Pairing, page 17).

Entering the device ID: Allows you to add a handheld device contact that is not in the area. This method 
requires the contact to find and communicate their handheld device code to the person adding the device 
contact.
This method is helpful when you would like to add a handheld device contact during a hunt, but you are not 
near the device. For example, if you are adding another member of your hunting party to your handheld 
device, but you do not own the device (Adding a Contact Using a Contact ID, page 17).

Sharing wirelessly using ANT+ wireless technology: Allows you to add a handheld device that you do not own 
as a contact. This method does not require the contact to find and communicate their device code to the 
person adding the device. The two handheld devices must be within a range of 3 m (10 ft.) to share data 
wirelessly.
This method is helpful when you want to add a handheld device during a hunt without entering the device ID 
(Adding a Contact Using Wireless Pairing, page 17).

Adding a Contact Using Wireless Pairing
Before you can add a contact wirelessly, you should be near the contact's handheld device.
1 Select Dog List > .
2 Select an option:

• On your handheld device select Add > Pair Handheld, and follow the on-screen instructions.
• To add a contact by receiving the information from the contact's handheld device, select Add > Receive 

from Handheld.
3 After successfully adding the contact, enter the name of the contact, and select .
The contact is added to your handheld device.
You can repeat this procedure using another hunter's handheld device to add your contact ID to that device.

Adding a Contact Using a Contact ID
Before you can add a hunter using a contact ID, the hunter must find the contact ID (Finding Your Contact ID, 
page 18) and send it to you.
If you are not near the hunter you want to add, you can add the hunter using a contact ID.
1 On your handheld device, select Dog List >  > Add > Enter ID.
2 Select the contact ID for the contact you are adding.
3 Enter the name of the contact, and select .
The contact is added to your handheld device.
You can repeat this procedure using another hunter's handheld device to add your contact ID to that device.

Initiating an Emergency Alert
Before you can initiate an emergency alert, you must turn on the transmitter (Turning On and Off the 
Transmitter, page 16).
Before someone can receive your emergency alert, someone must add you as a contact (Adding a Contact 
Using Wireless Pairing, page 17).
You can use an emergency alert when you need immediate assistance and you are away from your group.

Select Dog List >  >  > Yes.
When your contact accepts your emergency alert request, the device displays a message indicating that 
your contact has started navigating to your location.

After receiving the alert, your contacts can navigate to your location.
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Sending a Message to Your Contacts
Before you can send a message to your contacts, you must turn on the transmitter (Turning On and Off the 
Transmitter, page 16).
You can send and receive automated messages. There are 18 messages you can choose from, such as "Help" 
and "I'm Coming."
1 Select Dog List >  > Message.
2 Select a message.
The message is sent to your contacts with your name before the message. Anyone tracking your handheld 
device receives the message.

Tracking a Contact
You can keep track of contacts' locations using the map.

Select .

Finding Your Contact ID
Press  to open the status page.
The contact ID for your handheld device is listed under the My ID option.

Changing Your Contact ID
If you are experiencing interference from other collars or handheld devices in the area, you might need to 
change the contact ID for your handheld device.
1 Press  to open the status page.
2 Select My ID > ID.
3 Select a contact ID that is not yet assigned to another device in the area.
Each time a contact changes their contact ID, you must update the contact ID in your handheld device 
(Updating a Contact ID, page 18).

Updating a Contact ID
If a contact has changed their contact ID, you can quickly update the contact ID in your handheld device.
1 Select Dog List > .
2 Select the contact.
3 Select  > Update ID.
4 Select the contact ID that matches the contact's new contact ID.

Hunting with the Alpha System
You can perform various tasks that can be helpful when you are hunting with the Alpha system.
• Mark your truck's location (Marking Your Truck Location, page 19).
• Track your dogs (Tracking Your Dog on the Map, page 12).
• Track your fellow hunters (Tracking a Contact, page 18).
• Mark the location of a covey (Marking a Covey, page 19).
• View your active hunt metrics (Active Hunt Metrics, page 19).
• Send messages to your fellow hunters (Sending a Message to Your Contacts, page 18).
• Turn on the collar light (Turning On the Collar Light, page 19).
• Put the collar into rescue mode to save battery power (Turning On Rescue Mode, page 19).
• Pause tracking while you move the dogs (Pausing Dog Tracking, page 19).
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Marking Your Truck Location
You can mark the location of the truck, so you can navigate back to your truck after the hunt.
1 Select Mark Waypoint > Truck.
2 Select Save.

Marking a Covey
You can mark a covey location and enter the estimated number of birds flushed and the number of birds taken.
1 Select Mark Waypoint > Covey.
2 Enter the number of birds flushed, the number of birds taken, and select OK.
3 Review and edit location information (optional).
4 Select Save.

Active Hunt Metrics
You can select Hunt from the main menu to view the active hunt metrics. The active hunt metrics page displays 
the active hunt time and distance traveled for your handheld device and each paired dog collar device. It also 
shows the dog status, such as on point, treed, or barking, if available. When you select End Hunt, the hunt timer 
and distance traveled stop recording.

Turning On the Collar Light
You can turn on the LEDs on the collar at night to help locate a dog or to warn drivers if a dog wanders near a 
road. The light is visible for up to 100 yards.
1 Select Dog List.
2 Select a dog.
3 Select Adjust Collar Light.
4 Select Continuous, Blink Slow, or Blink Fast.

TIP: Select different light setting for each dog to help you identify the dogs in the field.

Turning On Rescue Mode
You can turn on rescue mode to conserve battery power at the end of a long hunt or if your dog might get out of 
range.
1 Select Dog List.
2 Select a dog.
3 Select  > Rescue Mode.
After you have turned on rescue mode, it stays on until you turn it off.
When the collar battery power falls below 25%, the collar data updates only once every 2 minutes.

Pausing Dog Tracking
You can pause the tracking of a single dog during a hunt. This can be helpful if the dog is taking a break.
1 Select Dog List.
2 Select a dog.
3 Use the Active toggle switch to turn tracking on and off.
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Waypoints, Routes, and Tracks
Waypoints
Waypoints are locations you record and store in the device. Waypoints can mark where you are, where you are 
going, or where you have been. You can add details about the location, such as name, elevation, and depth.
You can add a .gpx file that contains waypoints by transferring the file to the GPX folder (Connecting the 
Handheld Device to a Computer, page 34).

Marking Your Current Location
1 Select Mark Waypoint.
2 Select an option:

• Select New.
• Select a default location name, such as Truck or Camp.

3 Edit the location information (optional).
4 Select Save.

Marking a Waypoint Using the Map
1 Select .
2 Select a location on the map.
3 Select the information bar at the top of the screen.
4 Select  > OK.

Editing a Waypoint
Before you can edit a waypoint, you must create a waypoint.
1 From the main menu, select Waypoint Manager.
2 Select a waypoint.
3 Select an item to edit, such as the name.
4 Enter the new information.

Repositioning a Waypoint to Your Current Location
You can change the position of a waypoint. For example, if you move your vehicle, you can change the location 
to your current position.
1 Select Waypoint Manager.
2 Select a waypoint.
3 Select  > Reposition Here.
The waypoint location changes to your current location.

Moving a Waypoint on the Map
1 Select Waypoint Manager.
2 Select a waypoint.
3 Select  > Move Waypoint.
4 Select the new location on the map.
5 Select Move.
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Increasing the Accuracy of a Waypoint Location
You can refine a waypoint location for more accuracy. When averaging, the device takes several readings at the 
same location and uses the average value to provide more accuracy.
1 Select Waypoint Manager.
2 Select a waypoint.
3 Select  > Average Location.
4 Move to the waypoint location.
5 Select Start.
6 Follow the on-screen instructions.
7 When the confidence status bar reaches 100%, select Save.
For best results, collect 4 to 8 samples for the waypoint, waiting at least 90 minutes between samples.

Projecting a Waypoint
You can create a new location by projecting the distance and bearing from a marked location to a new location.
1 Select Waypoint Manager.
2 Select a waypoint.
3 Select  > Project Waypoint.
4 Enter the bearing, and select .
5 Select a unit of measure.
6 Enter the distance, and select .
7 Select Save.

Deleting a Waypoint
1 Select Waypoint Manager.
2 Select a waypoint.
3 Select  > Delete > Delete.

Routes
A route is a sequence of waypoints or locations that leads you to your final destination.

Creating a Route
1 Select Route Planner > Create Route > Select First Point.
2 Select a category.
3 Select the first point on the route.
4 Select Use > Select Next Point.
5 Select a point.
6 Repeat steps 3 through 5 to add all the points in the route.

Editing the Name of a Route
1 Select Route Planner.
2 Select a route.
3 Select Change Name.
4 Enter the new name, and select .
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Navigating a Saved Route
1 Select Route Planner.
2 Select a route.
3 Select View Map > Go.

Editing a Route
1 Select Route Planner.
2 Select a route.
3 Select Edit Route.
4 Select a point.
5 Select an option:

• To view the point on the map, select Review.
• To change the order of the points on the route, select Move Up or Move Down.
• To insert an additional point on the route, select Insert.

The additional point is inserted before the point you are editing.
• To remove the point from the route, select Remove.

Reversing a Route
1 Select Route Planner.
2 Select a route.
3 Select Reverse Route.

Viewing the Active Route
1 Select Active Route.
2 Select a point in the route to view additional details.

Deleting a Route
1 Select Route Planner.
2 Select a route.
3 Select Delete Route.

Recordings
Your device records your path as an activity. Activities contain information about points along your recorded 
path, including time, location, and elevation for each point.

Recording Track Logs
By default, the device automatically starts recording your path as a track when it is turned on and has acquired 
satellite signals. You can pause and start recording manually.
1 Select Track Manager > My Track.
2 Select an option:

• To control the current track recording, select the current track tab.
• To view data fields for the track, select the information tab.
• To view the current track on the map, select the map tab.
• To view the elevation plot for the current track, select the elevation plot tab.
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Viewing Details about the Track
1 Select Track Manager.
2 Select a track.
3 Select .

The beginning and the end of the track are marked by flags.
4 Select the information bar along the top of the screen.

Information about the track is listed.

Viewing the Elevation Plot of a Track
1 Select Track Manager.
2 Select a track.
3 Select .

Navigating to the Start of a Track
You can navigate back to the beginning of a track. This can be helpful when finding your way back to camp or 
the trail head.
1 Select Track Manager > My Track > .
2 Select TracBack.

Changing the Track Color
1 Select Track Manager.
2 Select a track.
3 Select  > Color.
4 Select a color.

Saving the Current Track
1 From the main menu, select Track Manager.
2 Select My Track > Save.

Clearing the Current Track
Select Track Manager > My Track > Discard.

Deleting a Track
1 Select Track Manager.
2 Select a track.
3 Select  > Delete.

Navigation
You can navigate routes and tracks to a waypoint, geocache, or any saved location in the device. You can use 
the map or the compass to navigate to your destination.
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Map
 represents your location on the map. As you travel, the icon moves and leaves a track log. Waypoint names 

and symbols appear on the map. When you are navigating to a destination, your route is marked with a line on 
the map.
When the map orientation is Track Up, objects on the map appear to rotate around your position. As you travel, 
the entire map reorients in the direction you are facing. You can stabilize the objects by setting the orientation 
to North Up (Map Settings, page 28).
To open the map, select .

Measuring Distance on the Map
You can measure the distance between two locations.
1 From the map, select a location.
2 Select  > Measure Distance > Use.
3 Move the pin to another location on the map.

Compass
The handheld device has a 3-axis, tilt-compensated compass. You can use a bearing pointer or a course pointer 
to navigate to your destination.

Calibrating the Compass
NOTICE

Calibrate the electronic compass outdoors. To improve heading accuracy, do not stand near objects that 
influence magnetic fields, such as vehicles, buildings, and overhead power lines.

You should calibrate the compass after moving long distances, experiencing temperature changes, or removing 
the battery.
1 Select Compass >  > Calibrate Compass > Start.
2 Follow the on-screen instructions.

Navigating with the Bearing Pointer
When navigating to a destination,  points to your destination, regardless of the direction you are moving.
1 While navigating to a destination, select Compass.
2 Turn until  points toward the top of the compass, and continue moving in that direction to the destination.

Where To? Menu
You can use the Where To? menu to find a destination to navigate to. Not all Where To? categories are 
available in all areas and maps.

Finding a Waypoint by Name
1 Select Navigation > Where To? > Waypoints >  > Spell Search.
2 Enter the name.
3 Select .

Navigating with Sight 'N Go
You can point the device at an object in the distance, lock in the direction, and navigate to the object.
1 Select Navigation > Compass >  > Sight 'N Go.
2 Point the device at an object.
3 Select Lock Direction > Set Course.
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Elevation Plot
By default, the elevation plot displays the elevation for an elapsed time.
To open the elevation plot, select Track Manager > My Track > .

Calibrating the Barometric Altimeter
You can calibrate the barometric altimeter manually if you know the correct elevation or the correct barometric 
pressure.
1 Go to a location where the elevation or barometric pressure is known.
2 Select Track Manager > My Track >  >  > Altimeter Setup > Calibrate Altimeter.
3 Follow the on-screen instructions.

Navigating to a Point on the Plot
1 Select Track Manager > My Track > .
2 Select an individual point on the plot.
3 Select  > View Map.
4 Select Go.

Changing the Plot Type
You can change the elevation plot to display pressure and elevation over time or distance.
1 Select Track Manager > My Track >  >  > Altimeter Setup > Plot Type.
2 Select an option.

Resetting the Elevation Plot
Select Track Manager > My Track >  >  > Reset.

Trip Computer
The trip computer displays your current speed, average speed, maximum speed, trip odometer, and other 
helpful statistics. You can customize the trip computer layout, dashboard, and data fields (Customizing the Trip 
Computer Data Fields, page 25).
To open the trip computer, select Trip Computer.

Customizing the Trip Computer Data Fields
1 Select Navigation > Trip Computer.
2 Select a data field to customize.
3 Select a category or select All Categories.
4 Select the new data field.

For data field descriptions, see Data Field Options, page 42.

Resetting the Trip Computer
For more accurate trip information, reset the trip computer before beginning a trip.

Select Navigation > Trip Computer >  > Reset Trip.

Applications
Additional device features can be found in the applications. You can customize the main menu to display 
additional applications (Customizing the Main Menu, page 27).
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Setting a Proximity Alarm
Proximity alarms alert you when you or your dogs are within a specified range of a particular location. A tone 
sounds when you enter the designated radius.
1 Select Proximity Alarms.
2 Select Create Alarm.
3 Select a category.
4 Select a location.
5 Select Use.
6 Enter a radius.
When you enter an area with a proximity alarm, the device sounds a tone.

Calculating the Size of an Area
1 Select Area Calculation > Start.
2 Walk around the perimeter of the area you want to calculate.
3 When finished, select Calculate.

Setting an Alarm
1 Select Alarm Clock.
2 Select  and  to set the time.
3 Select Turn Alarm On.
The alarm sounds at the selected time. If the device is off at the alarm time, the device turns on and sounds the 
alarm.

Using the Competition Timer
1 Select Competition Timer.
2 Select an option:

• Select  to start and pause the competition timer.
• Select  to reset the competition timer.
• Select  to set the competition timer duration and alerts.
• Select  from the list to create a customized timer that counts up from zero.

Satellite Page
The satellite page shows your current location, GPS accuracy, satellite locations, and signal strength.

Changing the Satellite View
By default, the satellite view is with North at the top. You can change the view of the satellites to be oriented 
with your current track toward the top of the screen.

Select Satellite >  > Track Up.

Turning Off GPS
Select Satellite >  > Satellite Setup > Satellite System > Demo Mode.

Simulating a Location
1 Select Satellite >  > Satellite Setup > Satellite System > Demo Mode.
2 Select  > Set Location On Map.
3 Select a location.
4 Select Use.
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Downloading BirdsEye Imagery
Before you can download BirdsEye imagery directly to your device, you must connect to a wireless network 
(Connecting to a Wireless Network, page 16).
1 Select BirdsEye Direct > Download Imagery.
2 Select an option:

• To download BirdsEye imagery files for a specific location or area, select Location, and select a category.
NOTE: The location defaults to your current location.

• To edit the name of the downloaded imagery files, select Name.
• To select an image quality option, select Detail.
• To define the size of the area to be shown in the downloaded imagery files, select Radius, and enter a 

distance from the selected location.
An estimated file size appears for the selected image quality and radius. You should verify your device has 
enough available storage space for the imagery file.

3 Select Download.

Customizing Your Device
Customizing the Main Menu
1 From the main menu, select Setup > Main Menu.
2 Select an option:

• To move a menu item, select a menu item, and select a new location.
• To delete a menu item from the list, select a menu item, and select Remove.
• To add a new menu item to the list, or to place an item on the list after you have removed it, select Add 

Item Here.
• To reset the order of all items in the menu, select  > Restore Defaults.

Customizing the Data Fields
You can customize the data fields and dashboards of the map, compass, elevation plot, and trip computer.
1 Open the page for which you will change the data fields.
2 Select a data field to customize.
3 Select the new data field.

For data field descriptions, see Data Field Options, page 42 .

System Settings
Select Setup > System.
Satellite: Sets the satellite system options and enables or disables the use of Wide Area Augmentation 

System/European Geostationary Navigation Overlay Service (WAAS/EGNOS) data.
Language: Sets the text language on the device.

NOTE: Changing the text language does not change the language of user-entered data or map data, such as 
street names.

Mass Storage Mode: Sets whether your device goes into mass storage mode when it is connected to the 
computer.

Broadcast Dog Data: Automatically sends dog data to compatible devices.
Units: Sets the units of measure.
Time: Sets the time zone and format.
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Display Settings
Select Setup > Display.
Backlight Timeout: Adjusts the length of time before the backlight turns off.
Battery Save: Saves the battery power and prolongs the battery life by turning off the screen when the backlight 

times out (Turning On the Handheld Battery Save Mode, page 33).
Appearance: Sets the displayed accent colors for day and night.
Screen Capture: Allows you to save the image on the device screen.
Accessibility: Adds or changes device features to make your device more accessible (Accessibility Settings, 

page 28).

Accessibility Settings
Select Setup > Display > Accessibility.
Touch Sensitivity: Sets the touchscreen sensitivity.
Review Text Size: Adjusts the size of the text.
Scroll Controls: Adds scroll arrows to the screen when a menu, list, or grid is scrollable.

Setting the Device Tones
You can customize tones for messages, keys, warnings, and alarms.
1 Select Setup > Tones & Alerts.
2 Select a tone for each audible type.

Setting Dog Alerts
You can adjust how the handheld device alerts you to certain actions of the dog.
1 Select Setup > Tones & Alerts > Dog Alerts.
2 Select an action.
3 Select the method the device uses to alert you for this action.

Map Settings
Select Setup > Map.
Configure Maps: Enables or disables the maps currently loaded on the device.
Tracked Devices: Opens the map settings options for tracked devices (Tracked Devices Map Settings, 

page 28).
Show Training Bar: Displays the training bar on the map.
Show Data Fields: Displays configurable data fields on the map.
Advanced: Opens the advanced map settings (Advanced Map Settings, page 29).

Tracked Devices Map Settings
Select Setup > Map > Tracked Devices.
Auto Zoom: Allows the map to zoom out automatically, so the selected devices are always displayed on the 

map.
Dog Tracks on Map: Determines how much of the track log for a tracked dog collar appears on the map.
Handheld Tracks on Map: Determines how much of the track log for a tracked handheld device appears on the 

map.
Dog Display: Enables and disables the dog information shown on the map.
Show Offscreen Dogs: Enables or disables the offscreen dog indicator on the map.
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Advanced Map Settings
Select Setup > Map > Advanced.
Orientation: Adjusts how the map is shown on the page. North Up shows North at the top of the page. Track Up 

shows your current direction of travel toward the top of the page. Automotive Mode shows an automotive 
perspective with the direction of travel at the top.

Shaded Relief: Shows detail relief on the map (if available) or turns off shading.
Map Pointer: Displays the directional pointer on the map.
Text Size: Sets the text size for map items.

Tracks Settings
Select Setup > Tracks.
Record Method: Sets how the device records track data. The Smart recording option allows for longer track 

recordings. The Every Second recording option provides more detailed track recordings, but may not record 
entire tracks that last for longer periods of time.

Auto Save: Allows you to customize the Auto Save settings (Auto Save Settings, page 29).
Auto Start: Starts recording a track automatically when the device acquires satellites.

Auto Save Settings
When Full: Automatically saves the current recording and starts a new one when the current recording is near 

20,000 track points.
Daily: Automatically saves the previous day's recording and starts a new one when you turn on the device 

during a new day.
Weekly: Automatically saves the previous week's recording and starts a new one when you turn on the device 

during a new week.
Auto: Automatically saves the current recording based on its length and the number of track points taken.
Never: Never saves the current recording automatically. When the current recording nears 20,000 track points, 

the device filters the active track to remove redundant points while retaining the shape and history of the 
recording. Unfiltered points are saved in a temporary GPX and FIT file that is saved or discarded when the 
recording stops.
NOTE: When importing FIT activities or GPX tracks with more than 20,000 track points, the device filters the 
line to fit in the device memory and improve map drawing performance, while retaining the shape and history 
of the recording. The FIT and GPX files retain all of their original track points.

Routing Settings
The available routing settings vary based on whether Direct Routing is enabled or disabled.
Select Setup > Routing.
Direct Routing: Enables or disables direct routing. Direct routing calculates the most direct route possible to 

the destination.
Activity: Sets an activity while routing. The device calculates routes optimized for the type of activity you are 

doing.
Calculation Method: Sets the method used to calculate your route.
Lock On Road: Locks the blue triangle, which represents your position on the map, onto the nearest road. This 

is most useful when driving or navigating on roads.
Off Route Recalculation: Sets recalculation preferences when navigating away from an active route.
Avoidance Setup: Sets the types of roads, terrain, and transportation methods to avoid while navigating.
Route Transitions: Sets how the device routes from one point on the route to the next. This setting is available 

only for some activities. The Distance option routes you to the next point on the route when you are within a 
specified distance of your current point.
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Sensors Settings
Select Setup > Sensors.
Tempe Sensor: Allows you to pair a tempe™ sensor and turn a paired tempe sensor on and off.
Xero: Allows you to enable or disable your sharing status and make sharing public or private.

NOTE: You can share your location from a compatible Xero® device.

Changing the Units of Measure
You can customize units of measure for distance and speed, elevation, and temperature.
1 Select Setup > System > Units.
2 Select a measurement type.
3 Select a unit of measure for the setting.

Position Format Settings
NOTE: You should not change the position format or the map datum coordinate system unless you are using a 
map or chart that specifies a different position format.
Select Setup > System > Units > Position Format.
Position Format: Sets the position format in which a location reading appears.
Map Datum: Sets the coordinate system on which the map is structured.
Map Spheroid: Shows the coordinate system the device is using. The default coordinate system is WGS 84.

Device Information
Viewing E-label Regulatory and Compliance Information
The label for this device is provided electronically. The e-label may provide regulatory information, such as 
identification numbers provided by the FCC or regional compliance markings, as well as applicable product and 
licensing information.
1 Select Setup.
2 Select About.

Support and Updates
• You can update software and maps for your handheld device and compatible dog collar device using Garmin 

Express™.
• Go to support.garmin.com for FAQs, videos, and more information.

Product Updates
On your computer, install Garmin Express (www.garmin.com/express).
This provides easy access to these services for Garmin devices:
• Software updates
• Map updates
• Product registration
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Device Care
NOTICE

Do not store the device where prolonged exposure to extreme temperatures can occur, because it can cause 
permanent damage.
Never use a hard or sharp object to operate the touchscreen, or damage may result.
Avoid chemical cleaners, solvents, and insect repellents that can damage plastic components and finishes.
Secure the weather cap tightly to prevent damage to the USB port.
Avoid extreme shock and harsh treatment, because it can degrade the life of the product.

Cleaning the Device
1 Wipe the device using a cloth dampened with a mild detergent solution.
2 Wipe it dry.
After cleaning, allow the device to dry completely.

Cleaning the Touchscreen
1 Use a soft, clean, lint-free cloth.
2 If necessary, lightly dampen the cloth with water.
3 If using a dampened cloth, turn off the device and disconnect the device from power.
4 Gently wipe the screen with the cloth.

Specifications

Alpha Handheld Device Specifications
Battery type Rechargeable, replaceable lithium-ion 1

Battery life Up to 20 hr.

Operating temperature range From -20° to 60°C (from -4° to 140°F)

Charging temperature range From 0° to 45°C (from 32° to 113°F)

Long-term storage temperature range From 0° to 25°C (from 32° to 77°F)

VHF wireless range Up to 14.5 km (9 mi.)

ANT+ low power wireless range About 3 m (10 ft.)

Wireless frequencies/protocols 152-169 MHz @ 32.5 dBm maximum, 2.4 GHz @ 14.8 dBm maximum

SAR (body) 0.66 W/kg simultaneous

Water rating IEC 60529 IPX72

1 Only for use with Garmin part number 361-00053-04.
2 The device withstands incidental exposure to water of up to 1 m for up to 30 min. For more information, go to www.garmin.com/waterrating.
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Dog Collar Device Specifications
Battery type Internal rechargeable lithium-ion battery

Battery life From 20 to 40 hr.

Operating temperature range From -20° to 60°C (from -4° to 140°F)

Charging temperature range From 0° to 40°C (from 32° to 104°F )

ANT® wireless range Up to 10 m (32.8 ft.)

VHF radio range Up to 14.48 km (9 mi.)

Wireless frequencies/protocols 152-155 MHz @ 31.6 dBm maximum, 2.4 GHz @ 23.1 dBm maximum 

Water rating 1 ATM1

Mini Dog Collar Device Specifications
Battery type Rechargeable, replaceable lithium-ion

Battery life Up to 16 to 30 hr., typical use

Operating temperature range From -20° to 60°C (from -4° to 140°F)

Charging temperature range From 5° to 40°C (from 41° to 104°F)

ANT wireless range Up to 5 m (16.4 ft.)

VHF radio range Up to 6.44 km (4 mi.)

Wireless frequencies/protocols 152-155 MHz @ 31.6 dBm maximum, 2.4 GHz @ 23.1 dBm maximum

Water rating 1 ATM1

Battery Information
 WARNING

This product contains a lithium-ion battery. To prevent the possibility of personal injury or product damage 
caused by battery exposure to extreme heat, store the device out of direct sunlight.
Do not use a sharp object to remove batteries.

 CAUTION
Contact your local waste disposal department to properly recycle the batteries.

Long-Term Storage
NOTICE

The normal long-term decrease in the charging capacity of lithium-ion batteries can be accelerated by exposure 
to elevated temperatures. Storing a fully charged device in a location with a temperature outside the long-term 
storage temperature range can significantly reduce its recharging capacity.

When you do not plan to use the handheld device for several months, the battery should be removed. Stored 
data is not lost when the battery is removed.
When you do not plan to use the collar for several months, the battery should be charged to about 50%. The 
device should be stored in a cool, dry place with temperatures around the typical household level. After storage, 
the collar should be fully recharged before use.

1 The device withstands pressure equivalent to a depth of 10 m. For more information, go to www.garmin.com/waterrating.
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Maximizing the Battery Life
You can do several things to extend the life of the batteries in the handheld device and collar.
• Reduce the backlight brightness (Adjusting the Backlight Brightness, page 33).
• Reduce the backlight timeout (Adjusting the Backlight Timeout, page 33).
• Turn off the transmitter (Turning On and Off the Transmitter, page 16).
• Use battery save mode (Turning On the Handheld Battery Save Mode, page 33).
• Put the dog collar device into rescue mode to conserve the collar battery (Turning On Rescue Mode, 

page 19).
• Extend the duration for the collar update rate to conserve the collar battery (Changing the Dog Collar Device 

Update Rate, page 33).

Adjusting the Backlight Brightness
Extensive use of screen backlighting can significantly reduce battery life. You can adjust the backlight 
brightness to maximize the battery life.
NOTE: The backlight brightness may be limited when the battery is low.
1 Select .
2 Use the slider bar to adjust the backlight brightness.
The device may feel warm when the backlight setting is high.

Adjusting the Backlight Timeout
You can decrease the backlight timeout to maximize the battery life.
1 Select Setup > Display > Backlight Timeout.
2 Select an option.

Changing the Dog Collar Device Update Rate
Before you can change the collar update rate, the collar must be turned on and within range of the handheld 
device.
You can select a longer duration for the update rate to conserve battery power.
1 Select Dog List.
2 Select a dog.
3 Select Update Rate.
4 Select an option.

Turning On the Handheld Battery Save Mode
You can use battery save mode to prolong the battery life.

Select Setup > Display > Battery Save > On.
When in battery save mode, the screen shuts off when the backlight times out.

Saving Energy While Charging the Device
You can turn off the device display and all other features while charging.
1 Connect your device to an external power source.

The remaining battery capacity appears.
2 Hold the power key for 4 to 5 seconds.

The display turns off, and the device goes into a low power, battery charging mode.
3 Charge the device completely.

Data Management
The device has a memory card slot for additional data storage.
NOTE: The device is compatible with Windows® 7 and newer, and Mac® OS 10.4 and newer.
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Installing a Memory Card
 WARNING

Do not use a sharp object to remove user-replaceable batteries.

You can install a microSD memory card in the handheld device for additional storage or pre-loaded maps.
1 Turn the D-ring counter-clockwise, and pull up to remove the cover.
2 Remove the battery.
3 Slide the card holder to the left and lift up.

4 Place the memory card with the gold contacts facing down.
5 Close the card holder.
6 Slide the card holder to the right to lock it.
7 Replace the battery and cover.

Connecting the Handheld Device to a Computer
NOTICE

To prevent corrosion, thoroughly dry the USB port, the weather cap, and the surrounding area before charging or 
connecting to a computer.

1 Lift the weather cap .

2 Plug the small end of the USB cable into the USB connector  on the device.
3 Plug the other end of the USB cable into an available USB port on the computer.

Your device appears as a removable drive in My Computer on Windows computers and as mounted 
volumes on Mac computers.
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Connecting the Collar to a Computer
NOTICE

To prevent corrosion, you should dry the contacts on the collar and the surrounding area before connecting the 
charging clip.

1 Snap the charging clip onto the collar.
2 Plug the small end of the USB cable into the USB port on the charging clip cable.
3 Plug the other end of the USB cable into a USB port on the computer.

Transferring Dog Tracks to BaseCamp™

You can transfer the dog tracks to BaseCamp.
1 Connect the dog collar device to the computer (Connecting the Collar to a Computer, page 35).

The dog collar device turns on automatically.
2 Select  on the dog collar device.
3 Open BaseCamp.

BaseCamp recognizes the device.
4 Select Device > Receive from Device.
5 Select the dog collar device from the list, and click OK.
BaseCamp creates a folder of transferred data in My Collection.

Deleting Files
NOTICE

If you do not know the purpose of a file, do not delete it. Your device memory contains important system files 
that should not be deleted.

1 Open the Garmin drive or volume.
2 If necessary, open a folder or volume.
3 Select a file.
4 Press the Delete key on your keyboard.

NOTE: If you are using an Apple® computer, you must empty the Trash folder to completely remove the files.

Disconnecting the USB Cable
If your device is connected to your computer as a removable drive or volume, you must safely disconnect your 
device from your computer to avoid data loss. If your device is connected to your Windows computer as a 
portable device, it is not necessary to safely disconnect the device.
1 Complete an action:

• For Windows computers, select the Safely Remove Hardware icon in the system tray, and select your 
device.

• For Apple computers, select the device, and select File > Eject.
2 Disconnect the cable from your computer.

Resetting Data and Settings
The device offers options for deleting your user data and resetting all settings to the factory default values.
1 Select Setup > Reset.
2 Select an option:

• To reset all settings to the default values and save all user-entered information, select Reset All Settings.
• To delete all user data and reset all settings to the factory default values, select Delete All.
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Appendix
Accessories and Replacement Parts

Purchasing Accessories
• Optional accessories are available at garmin.com or from your Garmin dealer.

Optional Maps
You can use additional maps with the device, such as BirdsEye satellite imagery, City Navigator®, and Garmin 
HuntView™ Plus detailed maps. Detailed maps may contain additional points of interest, such as restaurants or 
marine services. For more information, go to buy.garmin.com or contact your Garmin dealer.

tempe
The tempe is an ANT+ wireless temperature sensor. You can attach the sensor to a secure strap or loop where 
it is exposed to ambient air, and therefore, provides a consistent source of accurate temperature data. You 
must pair the tempe with your device to display temperature data from the tempe.

Tips for Pairing ANT+ Accessories with Your Garmin Device
• Verify that the ANT+ accessory is compatible with your Garmin device.
• Before you pair the ANT+ accessory with your Garmin device, move 10 m (33 ft.) away from other ANT+ 

accessories.
• Bring the Garmin device within range 3 m (10 ft.) of the ANT+ accessory.
• After you pair the first time, your Garmin device automatically recognizes the ANT+ accessory each time it is 

activated. This process occurs automatically when you turn on the Garmin device and only takes a few 
seconds when the accessories are activated and functioning correctly.

• When paired, your Garmin device receives data from only your accessory, and you can go near other 
accessories.
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Dog Collar Device Battery Replacement Instructions
Dog Collar Device Components

Back plate

Power key

Battery connector

Battery cover

Battery

Power connector
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Removing the Old Battery
Before you replace the battery, you must remove all dirt, water, and debris from the device. You must also have 
a small Phillips screwdriver.
1 Remove the six screws from the outer edges of the back plate.

NOTE: You should leave the two inner screws in place.
2 Pry off the back plate.
3 Disconnect the battery connector and power connector.
4 Remove the screws that secure the battery cover.
5 Remove the battery cover and the battery.

Remember the orientation of the battery. You must install the new battery the same way.
After you remove the old battery, contact your local waste disposal department to properly recycle the battery.

Installing the New Battery
Before you replace the battery, you must remove the old battery (Removing the Old Battery, page 38). You also 
must have a small Phillips screwdriver. You may need a small flat screwdriver.
1 Install the new battery using the same orientation as the old battery.

The connector  should face the end nearest the power key, and the bump  where the wires connect to 
the battery should face toward the side with the charging clip contacts.

2 Replace the battery cover.
3 Replace the screws to secure the battery cover.
4 Connect the battery connector and power connector.

You may need to use a flat screwdriver to help secure the connectors.
5 Select the power key to test the connections.

When properly connected, a tone is emitted and the status LED blinks green.
6 Turn off the device.
7 Verify the gasket located inside the bottom cover is fully seated.
8 Replace the back plate.
9 Replace the six screws to secure the back plate.
After you install the new battery, charge the collar completely.
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Replacing the Mini Dog Collar Device Battery
Before you can replace the battery, you must remove all dirt, water, and debris from the device. You also need a 
small Phillips screwdriver and the security screwdriver included in the battery replacement kit.
1 Remove the screws from the L-shaped cover over the VHF antenna.
2 Pry off the L-shaped cover.
3 Remove the screws from the outer edges of the back plate.
4 Pry off the back plate.
5 Grip the battery connector wires close to the connector, and pull the connector perpendicular to the circuit 

board to disconnect the battery connector from the device.
6 Grip the power connector wires close to the connector, and pull the connector parallel to the circuit board to 

disconnect the power connecter from the device.
7 Remove the screws from the battery plate.
8 Remove the battery plate.
9 Remove the battery.

The battery fits tightly. It may be necessary to pry the battery out of the back plate using a non-sharp, non-
metal object.

10 Install the new battery into the front enclosure with the label side of the battery facing up, and the leading 
edge of the battery placed under the charging contact ledge of the device.

11 Replace the battery plate, and replace and tighten the two screws.

12 Verify the gasket is not damaged and is completely seated in the groove.
13 Connect the battery connector and the power connector to the device.

When properly installed, the connector plugs snap into the ports.
14 Replace the back plate, and replace and tighten the screws to secure the back plate.
15 Replace the L-shaped cover, and replace and tighten the screws to secure the L-shaped plate.
16 Verify the gasket is not sticking out of the device.

Replacing the Collar Strap
Before you replace the collar strap, you must remove all dirt, water, and debris from the device (Cleaning the 
Device, page 31).
1 Pull the collar strap out of the GPS antenna, antenna guide, and the dog device.

You may need to push and pull the collar strap to properly remove it. You may need to loosen the screw on 
the GPS antenna case, but do not remove them.

2 Thread the new collar strap through the dog device, antenna guide, and GPS antenna.
3 If necessary, tighten the screws that secure the GPS antenna case.
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Replacing the VHF Antenna in the Dog Collar Device
NOTICE

Do not excessively bend the band that connects the main device case with the GPS antenna.
When the L-shaped cover is removed, do not disturb the sealant opposite the VHF antenna, because this can 
damage the waterproof seal of the dog collar device.

Before you replace the VHF antenna, you must remove all dirt, water, and debris from the device (Cleaning the 
Device, page 31). Also, you need a small Phillips screwdriver.
1 Remove the 4 screws  from the L-shaped cover over the VHF antenna.

NOTE: You should note the location of the one short screw.
2 Pry off the L-shaped cover.

3 Remove the screw  securing the VHF antenna to the back plate.
4 Pull the length of the antenna from the antenna guide to remove the old antenna.
5 Loop the antenna guide around the collar strap, and thread the new VHF antenna through the guide.

This helps to point the antenna up.
6 Replace the screw securing the VHF antenna to the back plate.
7 Replace the L-shaped cover over the VHF antenna.
8 Replace the 4 screws on the L-shaped cover, replacing the short screw in the correct location.
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Changing the Fuse in the Vehicle Power Cable
NOTICE

When replacing the fuse, do not lose any of the small pieces and make sure they are put back in the proper 
position. The vehicle power cable does not work unless it is assembled correctly.

If your device does not charge in your vehicle, you may need to replace the fuse located at the tip of the vehicle 
adapter.
1 Rotate the end piece  counter clockwise to unlock it.

TIP: You may need to use a coin to remove the end piece.
2 Remove the end piece, the silver tip , and the fuse .
3 Insert a new fast-blow fuse that has the same current, such as 1 A or 2 A.
4 Place the silver tip in the end piece.
5 Push in the end piece and rotate it clockwise to lock it back into the vehicle power cable .
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Data Field Options
24 hr. Max. Temperature: The maximum temperature recorded in the last 24 hours.
24 hr. Min. Temperature: The minimum temperature recorded in the last 24 hours.
Accuracy of GPS: The margin of error for your exact location. For example, your GPS location is accurate to 

within +/- 12 ft. (3.65 m).
Alarm Timer: The current time of the countdown timer.
Ambient Pressure: The uncalibrated environmental pressure.
Ascent - Average: The average vertical distance of ascent since the last reset.
Ascent - Maximum: The maximum rate of ascent in feet per minute or meters per minute since the last reset.
Ascent - Total: The total elevation distance ascended since the last reset.
Automotive Turn: The direction of the next turn in the route. You must be navigating for this data to appear.
Average Lap: The average lap time for the current activity.
Barometer: The calibrated current pressure.
Battery Level: The remaining battery power.
Bearing: The direction from your current location to a destination. You must be navigating for this data to 

appear.
Calories: The amount of total calories burned.
Compass Heading: The direction you are moving based on the compass.
Course: The direction from your starting location to a destination. Course can be viewed as a planned or set 

route. You must be navigating for this data to appear.
Current Lap: The stopwatch time for the current lap.
Date: The current day, month, and year.
Descent - Average: The average vertical distance of descent since the last reset.
Descent - Maximum: The maximum rate of descent in feet per minute or meters per minute since the last reset.
Descent - Total: The total elevation distance descended since the last reset.
Distance to Dest.: The remaining distance to the final destination. You must be navigating for this data to 

appear.
Distance to Next: The remaining distance to the next waypoint on the route. You must be navigating for this 

data to appear.
Elapsed Track Time: The total time recorded. For example, if you start the timer and run for 10 minutes, then 

stop the timer for 5 minutes, then start the timer and run for 20 minutes, your elapsed time is 35 minutes.
Elevation: The altitude of your current location above or below sea level.
Elevation Above Ground: The altitude of your current location above ground level (if maps contain sufficient 

elevation information).
Elevation - Maximum: The highest elevation reached since the last reset.
Elevation - Minimum: The lowest elevation reached since the last reset.
ETA at Destination: The estimated time of day when you will reach the final destination (adjusted to the local 

time of the destination). You must be navigating for this data to appear.
ETA at Next: The estimated time of day when you will reach the next waypoint on the route (adjusted to the 

local time of the waypoint). You must be navigating for this data to appear.
Glide Ratio: The ratio of horizontal distance traveled to the change in vertical distance.
Glide Ratio to Dest.: The glide ratio required to descend from your current position to the destination elevation. 

You must be navigating for this data to appear.
GPS Elevation: The altitude of your current location using GPS.
GPS Heading: The direction you are moving based on GPS.
GPS Signal Strength: The strength of the GPS satellite signal.
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Grade: The calculation of rise (elevation) over run (distance). For example, if for every 10 ft. (3 m) you climb you 
travel 200 ft. (60 m), the grade is 5%.

Heading: The direction you are moving.
Lap Ascent: The vertical distance of ascent for the current lap.
Lap Descent: The vertical distance of descent for the current lap.
Lap Distance: The distance traveled for the current lap.
Laps: The number of laps completed for the current activity.
Lap Speed: The average speed for the current lap.
Last Lap Ascent: The vertical distance of ascent for the last completed lap.
Last Lap Descent: The vertical distance of descent for the last completed lap.
Last Lap Distance: The distance traveled for the last completed lap.
Last Lap Speed: The average speed for the last completed lap.
Last Lap Time: The stopwatch time for the last completed lap.
Location (lat/lon): The current position in latitude and longitude regardless of the selected position format 

setting.
Location (selected): The current position using the selected position format setting.
Location of Dest.: The position of your final destination. You must be navigating for this data to appear.
None: This is a blank data field.
Odometer: A running tally of distance traveled for all trips. This total does not clear when resetting the trip data.
Off Course: The distance to the left or right by which you have strayed from the original path of travel. You must 

be navigating for this data to appear.
Pointer: An arrow points in the direction of the next waypoint or turn. You must be navigating for this data to 

appear.
Speed: The current rate of travel.
Speed Limit: The reported speed limit for the road. Not available in all maps and in all areas. Always rely on 

posted road signs for actual speed limits.
Speed - Maximum: The highest speed reached since the last reset.
Speed - Moving Avg.: The average speed while moving since the last reset.
Speed - Overall Avg.: The average speed while moving and stopped since the last reset.
Stopwatch Timer: The stopwatch time for the current activity.
Sunrise: The time of sunrise based on your GPS position.
Sunset: The time of sunset based on your GPS position.
Temperature: The temperature of the air. Your body temperature affects the temperature sensor.
Time of Day: The current time of day based on your current location and time settings (format, time zone, 

daylight saving time).
Time to Destination: The estimated time remaining before you reach the destination. You must be navigating 

for this data to appear.
Time to Next: The estimated time remaining before you reach the next waypoint in the route. You must be 

navigating for this data to appear.
To Course: The direction in which you must move to get back on the route. You must be navigating for this data 

to appear.
Total Lap: The stopwatch time for all the completed laps.
Trip Odometer: A running tally of the distance traveled since the last reset.
Trip Time: A running tally of the total time spent moving and not moving since the last reset.
Trip Time - Moving: A running tally of the time spent moving since the last reset.
Trip Time - Stopped: A running tally of the time spent not moving since the last reset.
Turn: The angle of difference (in degrees) between the bearing to your destination and your current course. L 

means turn left. R means turn right. You must be navigating for this data to appear.
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Velocity Made Good: The speed at which you are closing on a destination along a route. You must be 
navigating for this data to appear.

Vertical Dist. to Dest.: The elevation distance between your current position and the final destination. You must 
be navigating for this data to appear.

Vertical Dist. to Next: The elevation distance between your current position and the next waypoint in the route. 
You must be navigating for this data to appear.

Vertical Speed: The rate of ascent or descent over time.
Vertical Speed to Dest.: The rate of ascent or descent to a predetermined altitude. You must be navigating for 

this data to appear.
Waypoint at Dest.: The last point on the route to the destination. You must be navigating for this data to 

appear.
Waypoint at Next: The next point on the route. You must be navigating for this data to appear.
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